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Visit the Integrations and Solutions Catalog at https://hpenterprise.sharepoint.com/teams/aztec/Portal/index.html to
explore how the products in the HPE Software catalog work together, exchange information, and solve business
needs.

Visit the Cross Portfolio Best Practices Library at https://hpln.hpe.com/group/best-practices-hpsw to access a
wide variety of best practice documents and materials.
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Chapter 1: Configuring SiteScope to
Communicate with HPOM and Operations
Management Overview
SiteScope, which is an agentless solution for IT infrastructure performance and availability monitoring, can
work together with Operations Manager (HPOM) andOperations Management in BSM 9.x, to provide a
powerful combination of agentless and agent-based infrastructuremanagement.

Note: SiteScope can also be integrated with Operations Manager i 10 (OMi 10) which is a separate
product from BSM andHPOM. For details on performing this integration, see the Operations Manager i -
HP SiteScope Integration section of the OMi Integrations Guide 10.00.

l Events. SiteScope communicates events to these applications using the HP Operations agent, which
must be installed on the SiteScope server. Events in SiteScope are based on SiteScopemonitor metric
status changes and alerts being triggered. SiteScope sends events by writing them to a log file which is
monitored by the HP Operations agent. The agent reads the data and converts it to events, which it
forwards to the HPOMmanagement server, or to BSM for use in Operations Management, Service Health,
and Service Level Management. For details on sending events, see "Configuring SiteScope to Send
Events to HPOM or Operations Management Overview" on page 14.

l Metrics Integration. SiteScopemakes its metrics data available for use in HP PerformanceManager (the
reporting component of HPOM) and PerformanceGraphing in BSM's Operations Management.

l ForPerformance Graphing, you can use either of the following data sources for reporting data to
BSM:

o Profile database in BSM, as part of the BSM integration (this is the recommended data source).

o HP Operations agent installed on the SiteScope server, as part of the Operations Manager metric
integration.

Note:While reportingmetrics data to the HP Operations agent is supported for Performance
Graphing in this release, HP plan to stop supporting it in the future, and recommend that you
use the BSM profile databasemethod instead. Reportingmetrics to the HP Operations agent
as part of the Operations Manager metric integration is still supported for makingmetrics
available in PerformanceManager.

l ForPerformance Manager, youmust use the HP Operations agent installed on the SiteScope server,
as part of the Operations Manager metric integration.

For details on reportingmetrics, see "Configuring SiteScope to Report Metrics for Use in HPOM or
Operations Management" on page 67.
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Note:

l This integration replaces the need to install the HP SiteScope Adaptor on the HPOM server that was
required for the earlier integration solution when using the basic alert script mechanism.

l Metrics integration using the HP Operations agent (wheremetrics data is used in Performance
Graphing in BSM's Operations Management) should not be confused with the BSM integration where
SiteScopemonitor metrics are used by the various BSM applications to calculate CI status (for
example, in Service Health, Service Level Management, and System Availability Management). For
details on BSMmetrics integration, see the Connecting to a BSM Server section of the Using
SiteScopeGuide in the SiteScope Help.

Tip: For best practices and troubleshooting for reporting data to BSM andHPOM products, see the
Integration with BSM andHPOM Best Practices Guide available from the SiteScope Help.

Event and Metrics Flow Diagram

Integration with HP Operations Manager Products
Chapter 1: Configuring SiteScope to Communicate with HPOM andOperations Management Overview
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HP Operations Agent Topology
HP Operations agent CIs are created when SiteScope is connected to HPOM, and HPOM is connected to
BSM.

When SiteScope is connected directly to BSM, SiteScope creates the agent CI through its usual topology
flow. When SiteScope sends its main topology (profile CI) and there is either an event or metrics integration
with Operations Manager active, it also sends the agent topology.

Note:

l The agent CI is deleted only when both event andmetrics integrations are removed.

l The agent CI is not deleted when SiteScope is disconnected from BSM, because SiteScope cannot
detect if the connection is through HPOM or BSM (the agent CI eventually disappears due to the
aging process).

Integration with HP Operations Manager Products
Chapter 1: Configuring SiteScope to Communicate with HPOM andOperations Management Overview
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Chapter 2: Centralized Template
Management from HPOM
This integration enables you to centrally manage and deploy templates frommultiple SiteScope instances
from within HPOM (this is not relevant when SiteScope is integrated with Operations Management).

Benefits
This integration provides the following benefits:

l Centralizedmanagement of templates across multiple SiteScope instances—you no longer have to worry
about templates getting out of sync or to manually sync templates.

l Version control for templates (including roll-back functionality).

l Automatic and robust deployment of templates based on group policy assignment (desired state handling).

l Scheduled roll out of template deployment.

l Reduced firewall configuration, leveraging existing Operations agent-HPOMmanagement server
connectivity.

l Unifiedmanagement of SiteScope and theOperations Agent through a single administrative console.

Note: This integration is currently not supported for HPOM forWindows.

Available Actions
Whenmanaging SiteScope templates with HPOM, you can perform the following actions:

l Export all templates from SiteScope and import them to HPOM as policies, which you can later on assign
and deploy. Use theExport to OM option in the Template shortcut menu in SiteScope to export
SiteScope templates to HPOMwhen SiteScope and HPOM are installed on the samemachine.

l Create or modify a template on SiteScope and thenmove this template to HPOM (only when SiteScope
and HPOM are installed on the same system). This means that you can either create a new template or
modify an existing template to contain the text or the variables that you choose.

l Deploy a SiteScope template or import template container from HPOM.

l Delete SiteScope templates.

Note:When deploying a template to SiteScope from HPOM, all mandatory SiteScope variables must
have a value set in the OM Policy. If not, the deployment fails.
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For details onmanaging SiteScope templates with HPOM, see the Deploying SiteScope Configuration with
HPOMGuide, available from the Home page of the SiteScope Help, or from the HPE Software Support site.

System Requirements
Template integration with HPOM is available provided your system conforms to the following requirements:

l SiteScope is installed and connected to a supported version of HPOM. For the HPOM versions supported
in this release, see the HP Operations Manager Integration Support Matrix in the SiteScope Deployment
Guide (available from the HPE Software Support site), or check the HPE Integrations site.

l Before installing SiteScope, you should create a predefined SiteScope configuration with a defined
username and password for the SiteScope Administrator. For details, see the Deploying SiteScope
Configuration with HPOMGuide, available from the SiteScope Help or from the HP Software Support site.

l TheOperations agent is installed on the SiteScope server. You can install Operations Agent 11.14 from
the root directory of the SiteScope releasemedia. For details, see the Installing SiteScope section of the
HPE  SiteScope Deployment Guide (available from the HPE Software Support site).

l Operations Manager integration is configured in SiteScope and theEnable exporting templates to HP
Operations Manager check box is selected in HP Operations Manager IntegrationMain Settings. For
details, see "How to Enable SiteScope to Send Events to HPOM or Operations Management" on page 19.

Integration with HP Operations Manager Products
Chapter 2: Centralized TemplateManagement from HPOM
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Chapter 3: SiteScope Failover and Operations
Manager Integration
The SiteScope Failover (automatedmirroring) solution provides support for Operations Manager event and
metrics integration.

Event Integration
To enable SiteScope Failover support for OM event integration, perform the steps in "How to Enable
SiteScope to Send Events to HPOM or Operations Management" on page 19, both for the primary SiteScope
and for the SiteScope Failover.

Event flow and host discovery flow work without any additional steps. For theMonitor Discovery integration,
follow the steps in "How to Enable the SiteScopeMonitor Discovery Policy" on page 36 for the primary
SiteScope only.

Notes and Limitations

l Since there is only one SiteScope service tree (and it is affected by events), it is not possible to know if it
is affected by what was reported from the primary or failover SiteScope.

l When the primary is down, events triggered frommonitors that aremonitoring the SiteScope server (in this
case, the SiteScope server is the failover) do not affect the service tree.

l Groups andmonitors added when the primary is down are not displayed in the service tree.

l The Drill Down to SiteScope tool works only when the primary SiteScope is running.

l If there are different agent configurations on the primary and SiteScope Failover (for example, an agent is
installed on a different path), the agent command on the failover server will not run from the Event
Integration preferences user interface and you need to enter the agent pathmanually beforehand.

Metrics Integration
SiteScope Failover provides support for OMmetrics integration.

Note:When using the Operations Agent as the data source for reportingmetrics to Operations
Management, SiteScope Failover reports metrics to the Operations Agent and not to the primary's agent.
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Chapter 4: Configuring SiteScope to Send
Events to HPOM or Operations Management
Overview
You can enable SiteScope to send events directly to the HPOMmanagement server and to BSM (for use in
Operations Management, Service Health, and Service Level Management). Events in SiteScope are based on
SiteScopemonitor metric status changes and alerts being triggered.

To enable SiteScope to send events, the HP Operations agent must be installed on the SiteScope server. You
can install the Operations Agent from the SiteScope installer package, or download it from the HPE Software
Support web site.

After the agent is installed, it must be configured in SiteScope Integration Preferences. This involves entering
the installation path of the agent and the host name or IP address of the HPOMmanagement or BSM
Gateway Server, and connecting the agent to HPOM or BSM. The agent then sends a connection request to
HPOM or BSM whichmust grant the certificate request (the HPOMmanagement server can be configured to
accept this client automatically).

After the certificate request has been granted on the HPOM or BSM server, a preconfigured log file policy
should be installed and signed on the agent installation on the SiteScope server. This enables SiteScope to
sign the preconfigured Operations Manager policies locally and automatically. This policy comes with
SiteScope, and is deployed from theOperations Manager Integration dialog box in SiteScope's Integration
Preferences.

When an event is triggered, SiteScope writes the event data to the
HPSiteScopeOperationsManagerIntegration.log file which is located in the <SiteScope root
directory>\logs directory. Each event is written as a separate line in the log. The log file policy instructs the
agent to read this file and create event messages that are sent to HPOM or BSM.

The format of the event attributes is determined using the event mapping template. The templatemaps
SiteScope runtime data to the event attribute values that are sent to the HPOMmanagement or BSM
Gateway Server when an event is triggered. For details on event mappings, see the section on Common
Event Mappings in the Using SiteScopeGuide in the SiteScope Help.

After the data is converted to an event, the agent sends the event to the HPOMmanagement/BSMGateway
Server. Events appear in:

l HPOM's Event Console.

l BSM's Operations Management Event Browser if you have an Event Management Foundation license,
and in Service Health for events that affect CIs. If Operations Management is not part of your BSM
installation, you can still view events that affect CI status using a health indicator in Service Health.
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The following diagram illustrates event data flow:

Note: The HP Operations agent can be configured either to report events to an HPOMmanagement or a
BSMGateway Server—not to both.

For details on configuring SiteScope to send events, see "How to Enable SiteScope to Send Events to HPOM
or Operations Management" on page 19.

Integration with HP Operations Manager Products
Chapter 4: Configuring SiteScope to Send Events to HPOM or Operations Management Overview
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Event Generation
You can configure events to be generated and sent to the HPOMmanagement server or to Operations
Management in BSM following a change in amonitor's metric status or when a SiteScope alert is triggered.

l Status Change. Every metric/counter status change is an event (for example, if the CPU utilization
status changes from Good to Error). You can choose whether events are triggered for metrics status
changes in themonitor's properties. By default, SiteScope sends an event for eachmetric status change
for themonitor instance.

You can change the default settings for sending events and the event attribute values used when an event
is triggered. The event attribute values are filled according to the event configurationmappings using the
monitor's properties. For details on event mappings, see the event mapping section in the Using
SiteScopeGuide in the SiteScope Help.

In addition to sending themonitor properties, SiteScope also sends health indicators or event type
indicators ("indicators") for themonitor instance. Events are categorized according to indicators. The BSM
event manager uses indicators to categorize events according to the type of occurrence in themanaged IT
environment (for example, CPU Load). Indicators that provide CI state information are then used to
calculate the CI.

Note: Status change is applicable only to metrics that are configured in themonitor's Thresholds
Settings.

l Alert. Every alert is an event. Since alerts are triggered per monitor, an event triggered by an alert can use
themonitor's properties, but not the indicators associated with a specific metric. Therefore, when
configuring an event alert, you canmanually select the indicator that is reported when an event is triggered
by an alert. As a result, the indicator is more generic, and you should select indicators that do not affect
health indicators in BSM.

You can choose whether an alert sends events to HPOM or BSM in the alert definition in the Operations
Manager Integration Settings panel.

Note:

l When a SiteScope alert is triggered, it is possible that two events are generated if both the alert
andmonitor are configured to send events. When configuring alerts to send events, you should not
also enable themonitors to send events. Conversely, if you want an alert for eachmetric status
change (together with health or event type indicators for themonitor instance), we do not
recommend also using alert events.

l SiteScope also includes threshold information in alerts that are sent to HPOM. In earlier versions
of SiteScope and BSM, it was not possible to include the thresholds created for monitors in alerts.

l In Operations Management, it is recommended to use alert events for notification purposes only.

Integration with HP Operations Manager Products
Chapter 4: Configuring SiteScope to Send Events to HPOM or Operations Management Overview
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Discovery Scripts and Drilling Down User to View
HPOM Events
When SiteScope is integrated with HPOM, theNode discovery and Monitor discovery policies are
activated for nodes andmonitors on the HPOMmanagement server.

Both discovery policies rely on the Integration Viewer user in SiteScope. This is the user provided by
SiteScope for drilling down from HPOM events. This user has been granted view permissions, and
permissions to refresh groups andmonitors. For details on users and user permissions, see the User
Management Preferences section of the Using SiteScopeGuide in the SiteScope Help.

Note:

l If the Integration Viewer user is deleted from UserManagement Preferences, this user type is
automatically created when SiteScope is restarted.

l If the Integration Viewer user properties are changed, youmust restart SiteScope to update the user
properties file, or you canmanually update the user properties in the
<SiteScope root directory>\conf\sitescope_connection.properties file.

When changing Integration Viewer user properties manually, the user login name and password
should be encrypted using the SiteScope Encryption Tool as follow:

a. Run the following batch file:

o For Windows: <SiteScope root directory>/tools/AutoDeployment/encrypt_
password.bat

o For UNIX: <SiteScope root directory>/tools/AutoDeployment/encrypt_
password.sh<SiteScope

b. Open a command prompt window.

o InWindows, drag and drop the file into your command prompt window.

o In UNIX, youmust run the .sh file from its directory.

c. Enter space and the password value (for example Mypassword). Click Enter.

d. Use the returned string as a value for the encrypted variable in the XML file. Youmuch change the
value of the attribute encrypted to yes and the value of the variable attribute to the returned
string.

For example, the following value was generated by the encryption tool: <deploy:variables
encrypted="yes" name="password" value="(sisp)d5JLOSWaVfE="/>

For details on deploying the discovery policies on the HPOMmanagement server, refer to the HPOM
documentation.

For troubleshooting discovery policy issues, see "Node Discovery andMonitor Discovery Troubleshooting"
on page 64.

Integration with HP Operations Manager Products
Chapter 4: Configuring SiteScope to Send Events to HPOM or Operations Management Overview
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Node Discovery Policy

When SiteScope is connected with HPOM, a node is automatically created and registered in HPOM for each
nodemonitored by SiteScope. This enables SiteScope to report all the nodes that it monitors to HPOM. Only
hosts for monitors which report events are sent to HPOM through the discovery policy.

Tip:When you are not connected to HPOM (if connected to Operations Management), it is
recommended to disable the node discovery by running the command: ovpolicy -disable -polname
SiteScope_Hosts_Discovery

Note:

l SiteScope does not report nodes or services to HPOM for monitors that are disabled, or are not
configured to send events.

l By default, SiteScope reports all the nodes that it monitors to HPOM every 5minutes. You canmodify
this frequency by adding the _timeOutRunDiscoveryPolicyMinutes= property to the <SiteScope
root directory>\groups\master.config file, and a value, in minutes, representing the reporting
frequency. For example, _timeOutRunDiscoveryPolicyMinutes=10means that the discovery policy
is run every 10minutes.

l When SiteScope uses an SSL connection, you need to update the node discovery policies batch file
with the trust store password and keystore password and run the policy again. For details, see the
"Update Discovery Policies when SiteScope uses SSL" on page 38.

Monitor Discovery Policy

This is an optional policy that must be activatedmanually on HPOM using the files in the
<SiteScope root directory>\tools\OMIntegration\
SiteScopeMonitorDiscoveryPolicy directory. After the policy has been activated, SiteScope runs the
SiteScope-OMmonitor discovery script when it is connected with HPOM.

This policy enables the HPOM Service Navigator to view the SiteScopemonitor tree in the HPOM service
maps. When new monitors, groups, or both, are added or changes aremade in the SiteScopemonitor tree, the
services tree is updated in HPOM to reflect these changes. In addition, when events arrive to HPOM, they
affect the SiteScope services tree and color all related nodes affected by them.

For details on how to enable themonitor discovery policy, see "How to Enable the SiteScopeMonitor
Discovery Policy" on page 36.

For details on enabling the tool to drill down to SiteScope from HPOM, see "How to Enable the Drill Down to
SiteScope Tool on HPOM forWindows" on page 32 and "How to Enable the Drill Down to SiteScope Tool on
HPOM for UNIX/Linux/Solaris" on page 34.

Integration with HP Operations Manager Products
Chapter 4: Configuring SiteScope to Send Events to HPOM or Operations Management Overview
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Chapter 5: How to Enable SiteScope to Send
Events to HPOM or Operations Management
This task describes how to enable SiteScope to be used to send events to the HPOMmanagement server or
BSMGateway Server.

1. Prerequisites
l Your systemmust conform to the following requirements:

o SiteScope version 11.00 or later is installed.

o For Operations Management, BSM 9.00 or later is installed.

Note: SiteScope can also be integrated with Operations Manager i 10 (OMi 10) which is a
separate product from BSM andHPOM. For details on performing this integration, see the
Operations Manager i - SiteScope Integration section of the OMi Integrations Guide 10.00.

o For HPOM, Operations Manager for UNIX 9.0x or later, or Operations Manager forWindows 8.1x
or later is installed.

Note: The node discovery, monitor discovery, and template integration are not supported for
all versions of HPOM. For details of the integrations that are supported and of any patch
requirements, refer to the Operations Manager (HPOM) Integration Support Matrix in the HP
SiteScope Deployment Guide (available from the HPE Software Support site).

l Only a SiteScope administrator user, or a user grantedEdit integration preferences andAdd, edit
or delete common event mappings permissions can configure the integration and event mappings.
For details on user permissions, see the User Management Preferences section of the Using
SiteScopeGuide in the SiteScope Help.

l (If SiteScope is installed on a RedHat ES Linux 6.0 64-bit environment) Youmust install the following
dependencies before installing the Operations Agent:

o Install compat-libstdc++-33-3.2.3-69.el6.i686.rpm on the Red Hat Enterprise Linux 6 x64 node.

Note: To install SiteScope with the Operations Agent on RHEL x64 in graphics mode, you
must run the installer with themachine default 64-bit JRE.

./<PRODUCT_NAME>_<VERSION>_setup.bin LAX_VM /usr/bin/java $@

For example, if /usr/bin/java points to the 64-bit JRE or JDK:

./HPSiteScope_11.30_setup.bin LAX_VM /usr/bin/java $@
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o Install compat-libstdc++-33-3.2.3-69.el6.ppc64.rpm on the Red Hat Enterprise Linux 6 PPC
node.

You can install the dependencies, using the yum packagemanager provided in Red Hat Enterprise
Linux, by running the command:

o yum install compat-libstdc++-33-3.2.3-69.el6.i686

or

o yum install compat-libstdc++-33-3.2.3-69.el6.ppc64

2. Install the Operations Agent on the SiteScope server
Install Operations Agent 11.14 from the SiteScope installer package, or download it from the HPE
Software Support web site (in the Search box, type "Operations Agent", select the relevant version,
under Document Type, select Patches, and locate the installation file).

Note: If an older version of the agent is already installed, or the agent is already integrated with
OMi/OMu/OMw, you should:

a. Upgrade the agent according to the instructions in the HPE Operations Agent 11.14 Installation
Guide.

b. Configure the agent using the SiteScope Configuration Tool as described in step 3 below.

OnWindows:

a. Log on to the node with the administrator privileges.

b. Go to the directory where you extracted the contents of the ISO file.

c. Run the following command to install the agent:

cscript oainstall.vbs -i –a

OnUNIX/Linux:

a. Log on to the node with the root privileges.

b. Go to the directory where you extracted the contents of the ISO file.

c. Run the following command to start the installation:

./oainstall.sh -i -a

d. When the installation is complete, the agent starts its operation on the node and all the necessary
components start running.

For more detailed installation instructions, see the HPE Operations Agent 11.14 Installation Guide,
available from the HPE Software Support site.

Integration with HP Operations Manager Products
Chapter 5: How to Enable SiteScope to Send Events to HPOM or Operations Management
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Note:

l Only Operations Agent version 11.14 is certified with SiteScope 11.30 or later.

l Use the -includeupdates installation option to install Operations Agent 11.14 with pre-packed
hotfixes. For details, refer to the Operations Agent 11.14 Installation Guide.

l To enable the Operations Manager event integration, the Operations Agent on the SiteScope
machinemust run under the same user as in SiteScope, namely a non-root user. For details, see
Configure an Agent to run Under an Alternative User on UNIX in the Operations Manager for
UNIX - HTTPS Agent Concepts and Configuration Guide.

3. Complete the Operations Agent installation using the SiteScope Configuration
Tool

Note: This stepmust be performed before integrating the Operations Agent to HPOM.

The Configuration Tool installs two components:

a. Run the SiteScope Configuration Tool on the SiteScope server:

o OnWindows: Select Start > All Programs > HP SiteScope > Configuration Tool.

o On Linux (graphic mode): Run <SiteScope install Directory>/bin/config_tool.sh.

o On Linux (consolemode): Run /opt/HP/SiteScope/bin/config_tool.sh -i console.

For more details on using the SiteScope Configuration Tool, see the HPE SiteScope Deployment
Guide (available from the HPE Software Support site).

b. In theConfigure HP Operations Agent installed separately option (HP Operations Agent option
in consolemode), select Configure HP Operations Agent to complete the installation of the
Operations Agent.

c. Restart SiteScope (if required).

d. (If the agent is installed on a RedHat ES Linux 6.0 environment) After installing the Operations
Agent, check the installation status in the log files.

o SiteScope log. This just shows whether the installation passed successfully or not.

Log file name: HPSiteScope_config_tool.log

Log file location:

l win- %temp% onWindows platforms

l /temp or /var/temp on UNIX/Linux platforms

(search for results of "installOATask")

o Operations Agent log files.

Log file name: oainstall.log, oapatch.log
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Log file location:

l %ovdatadir%\log onWindows platforms

l /var/opt/OV/log/ on UNIX/Linux platforms

4. (For Operations Management only) Configure the connection request to be
passed to the Data Processing Server if BSM is installed on a distributed
environment, or if BSM Gateway Servers are behind a load balancer
If BSM uses a separate Gateway and Data Processing Server, perform the following to enable the
request received on theGateway Server to be passed to the Data Processing Server:

a. In BSM, select Admin > Platform > Infrastructure Settings:

o Select Applications.

o Select Operations Management.

o In theCertificate Server Settings, locate theCertificate Server Host. Make sure that the value
matches the host name or IP address of the active BSM Data Processing Server that acts as the
certificate server host. If it does not match, change it accordingly.

Note: If the BSM Data Processing Server fails and automatic failover has been configured,
youmust change theCertificate Server Host setting to the name of the backup Data
Processing Server to handle new certificate requests. However, if you do not expect any
new certificate requests during the Data Processing Server failover timeframe, you can keep
the setting unchanged as it does not affect any event integrations configured previously.

b. Configure the Gateway Server:

o Change the active directory to the \bin directory by typing cd <HPBSM root directory>\bin.

o Run setup-secure-communication.bat and enter the DNS name of the Data Processing Server.

c. Configure the Data Processing Server:

o Change the active directory to the \bin directory by typing cd <HPBSM root directory>\bin.

o Run setup-secure-communication.bat and type g to grant the request (make sure that you grant
this request and not some other request).

d. If you are using a BSM failover environment with load balancer, make sure to keep the certificate
server of each Data Processing Server synchronized.

o Repeat steps b and c for every Gateway Server. It does not matter to which Data Processing
Server you send the certificate request because the Data Processing Servers already trust each
other. As a result, all Gateway Servers trust both Data Processing Servers and can communicate
with them regardless of which one is active at any givenmoment.
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o If you install a new certificate on the running Data Processing Server, you also have to install the
certificate on the secondary Data Processing Server which is used as failover. To install the new
certificate, run the following commands:

ovcert -importtrusted -file <newCertificateFilePath>

ovcert -importtrusted -file <newCertificateFilePath> -ovrg server

o Configure the load balancer to forward all HTTPS traffic that arrives on port 383 to the Gateway
Servers. This enables the certificate requests and event forwarding to work.

5. Configure the agent connection settings on the SiteScope server
In SiteScope Integration Preferences, configure the Operations agent connection settings to the HPOM
management server or BSM server.

a. Select Preferences > Integration Preferences. In the Integration Preferences page:

o Click theNew Integration button and select HP Operations Manager Integration, or

o Select an existing integration and click theEdit Integration button.

b. In the Operations Manager Integration dialog box, expand theHP Operations Manager Integration
Main Settings panel, and enter the following in theConnection Settings area:

o HP Operations Agent installation path. Path to the HP Operations agent installation on the
SiteScopemachine.

l OnWindows platforms, the installation path is automatically resolved from theOperations
Agent InstallDir key in the registry, and appears in this field. The default path is C:\Program
Files\HP\HP BTO Software\. If the key is not found, the field is left empty, and youmust
manually enter the agent installation path.

l OnUNIX platforms: SiteScope checks to see if the Operations Agent is installed in the default
/opt/OV path. If it is not there, the field is left empty, and youmust manually enter the agent
installation path.

If youmanually entered a different path, click theResolve Path button to restore the default
installation path found by SiteScope.

o HP Operations Manager/BSM server. Enter the name or IP address of the HPOM/BSM server
to which you want to connect. If you are connecting to a BSM-distributed environment, enter the
BSMGateway Server name or IP address. If your BSMGateway Servers are behind a load
balancer:

l For BSM data/topology integration: Enter the name or IP address of the load balancer that is
configured for users.

l For OM event integration (Operations Management in BSM): Enter the name or IP address of
the load balancer that is configured for data collectors.
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c. Click Connect to connect the agent to the HPOMmanagement or BSM server. This sends a
connection request from the agent to the specified server.

6. Accept the agent connection request on the HPOMmanagement server or
BSM Gateway/Web Processing server
l For HPOM:

In HPOM, you need to configure the SiteScope node, map the certificate request to this node, and
accept the certificate request.

i. In HPOM, add SiteScope as amanaged node.

l For HPOM forWindows, you can use the ovownodeutil command-line tool to add a node, or
you can use the user interface. For details, see the "Configure nodes" section in the HPOM
forWindows documentation.

l For HPOM for UNIX/Linux, you can use the opcnode command-line tool to add a node.

Example - Using the opcnode command line tool:

# opcnode -add_node node_name=<SiteScope_node_name> \net_type=<network_
type> mach_type=<machine_type> \group_name=<group_name> node_
type=<node_type>

For detailed information, see the HPOM for UNIX and Linux documentation:

l "Adding aManaged Node to the HPOMDatabase" in the Administrator’s Reference
Guide.

l "Install HPOM Software on HTTPS Nodes" and "Working with Certificates" in the
HTTPS Agent Concepts and Configuration Guide.

ii. List the pending certificate request IDs with the following command. If you want that detailed
information on every pending request is listed, use the -l option:

ovcm -listpending [-l]

Note the request ID for the SiteScope node.

For more information, see the ovcmmanual page.

iii. Grant the certificate request to the SiteScope node, with the following command:

ovcm -grant <SiteScope_node_request_id>

l For BSM:
o If you are integrating with BSM 9.20 or later, go toAdmin > Operations Manager > Certificate

Request, and follow the instructions to locate and grant your certificate request.

o If you are integrating with versions of BSM earlier than 9.20:

For BSM running on aGateway Server only, perform the following on the BSMGateway Server. If
BSM runs on a distributed environment, perform the following on the Data Processing Server.
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i. (Optional) Tomake sure that the OV Certificate Server process is running, run the command line
run ovc -status. If it is not running, run the command ovc -start or contact your BSM
administrator.

ii. Change the active directory to the \bin directory by typing cd <BSM root directory>\bin.

iii. Run setup-secure-communication.bat and type g to grant the request (make sure that you
grant this request and not some other request).

iv. Make sure that the request ID you are going to accept is associated with the agent's core ID. To
retrieve the agent's core ID, in SiteScope, click theAnalyze button in HP Operations Manager
Integration, or run the agent's ovcoreid command on the SiteScope server.

7. Install the log policies on the SiteScope server
After the certificate request has been granted on the HPOM/BSM server, click Install Policies in the
HP Operations Manager Integrations Main Settings panel of the HP Operations Manager Integration
dialog box. This installs and signs the preconfigured log file policy file on the Operations Agent.

Note:

l If an agent is connected to an HPOM or BSM server and you want to connect it to a different
server, youmust uninstall and reinstall the agent or redirect the agent to another server. For task
details, see "How to Reconnect the Operations Agent to a Different HPOM or BSM Server" on
page 30.

l Customizing the default integration polices is not supported. Any changes made to the default
integration policies results in SiteScope events being written to the event log only and not arriving
to the HPOM Event Console/Operations Management Event Browser.

8. Check connection status and send test message from the SiteScope server -
optional
If there are connectivity problems, you can perform problem analysis and check the status of the agent
and the certificate request.

a. In the HP Operations Manager Integration dialog box, expand theHP Operations Manager
Integrations Main Settings panel, and click Analyze.

Use the information supplied in the analysis results to perform problem analysis and for
troubleshooting. For example, you can verify connectivity between the agent and server by checking
the bbcutil connection protocol.

b. To check that the agent is connected to the HPOMmanagement or BSM server, expand theHP
Operations Manager Integrations Advanced Settings panel, type amessage in the Test
message text box, and click Send Test Message.

c. If the test is successful, the text message is displayed in the HPOM console or in the Operations
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Management Event Browser in BSM. This message is generated by a basic opcmsg policy
command.

9. (For HPOM only) Extend the integration with HPOM using monitor discovery -
optional
To enable the HPOM Service Navigator to view SiteScope groups andmonitors in the HPOM service
maps, youmust manually enable theMonitor discovery policy on HPOM using the files in the
<SiteScope root directory>\tools\OMIntegration\SiteScopeMonitorDiscoveryPolicy directory.

For details on how to enable the policy, see "How to Enable the SiteScopeMonitor Discovery Policy" on
page 36.

Note: To enable SiteScope Failover support for the Operations Manager event integration, follow the
steps for configuring themonitor discovery policy in "SiteScope Failover andOperations Manager
Integration" on page 12.

Tip: You can also use the Drill Down to SiteScope tool to enable opening the SiteScope user
interface from themonitor or group service that was discovered by themonitor discovery policy and
added to the HPOM Service Navigator.

l For details on enabling the tool on HPOM forWindows, see "How to Enable the Drill Down to
SiteScope Tool on HPOM forWindows" on page 32.

l For details on enabling the tool on HPOM for UNIX/Linux/Solaris, see "How to Enable the Drill
Down to SiteScope Tool on HPOM for UNIX/Linux/Solaris" on page 34.

10. Enable SiteScope to send events to HPOM or Operations Management
a. In the HP Operations Manager Integration dialog box, expand theHP Operations Manager

Integrations Main Settings panel, and in theConfiguration Settings area select Enable sending
events.

b. Configure the following settings as required:

o Connect directly to BSM. When the agent is connected to Operations Management, select to
automatically deactivate the node discovery policy if it was installed and enabled on the
SiteScope server. When this option is selected:

l TheEnable node discovery policy option is not available, and the node discovery policy is
disabled if it was installed and enabled on the SiteScope server.

l ThePrefer events over metrics in BSM Service Health (global preference) option is
automatically selected.

o Prefer events over metrics in BSM Service Health (global preference). Determines the
global default preference for influencing BSM's Service Health when both SiteScope events and
metrics are reported to Service Health (since indicators for SiteScope events andmetrics both
affect CIs). This is relevant only when both BSM andOperations Manager integrations are active,
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and are connected to the same BSM server (the BSM server is used instead of the HPOM
server).

If selected, theEvents option is set as the default preference for every new monitor created in
HP Integration Settings > BSM Service Health Preferences > BSM Service Health
affected by. If not selected,Metrics is the default preference for reporting data to BSM. By
default, this is selected.

Note: This setting does not override the preference already set for individual monitor
instances in themonitorProperties tab > HP Integration Settings > BSM Service
Health Preferences > BSM Service Health affected by box.

For more information on choosing the preference to use, see the section on integrating SiteScope
with BSM in the Integration with BSM andHPOM Best Practices Guide in the SiteScope Help.

o Enable node discovery policy. SiteScope enables the node discovery policy (if installed) on
the SiteScope server. This option is automatically selected when theConnect directly to BSM
option is cleared. For details on Node discovery, see "Discovery Scripts and Drilling DownUser
to View HPOM Events" on page 17.

o Enable exporting templates to HP Operations Manager. Enables exporting all templates
from SiteScope and importing them to HPOM as policies (only when SiteScope and HPOM are
installed on the same system), which you can later on assign and deploy from HPOM. For details
on the template integration with HPOM, see "Centralized TemplateManagement from HPOM" on
page 10.

11. Enable default event severity mappings to be used - optional
Severity mappings correlate the severity level in HPOM or BSM to themonitor threshold status in
SiteScope. You can use the default severity mappings or customize themapping between the Error,
Warning, Good, and Unavailable status threshold for eachmonitor instance in SiteScope and the
HPOM/BSM server in theHP Operations Manager Integrations Advanced Settings panel.

If Use default severity is selected, the default mappings are sent when:

l Events are created by a triggered alert.

l SiteScope is not connected to BSM.

l The indicator state and severity value is missing. For example, when usingmonitors that do not have
a defined topology.

Note:

l This option is not available when SiteScope is connected to BSM (and the default global severity
mappings cannot be sent).

l By default, the Warning state is mapped to Minor (not Warning).
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Note: You can override the severity mapping at themonitor level by modifying theSeverity attribute
in Common Event Mappings. For details, see "Configure event mappings for monitors and alerts -
optional" below.

12. Enable/Disable sending events for monitor instances and alerts
By default, each newly-createdmonitor instance is configured to send an event for eachmetric status
change, and each new alert is configured to send an event when triggered. Monitors and alerts that are
upgraded from earlier versions of SiteScope are not configured to send events.

l To disable sending events when there is a change of ametric status
(Good/Warning/Error/Unavailable) for amonitor instance, in themonitor properties for the selected
monitor instance, expandHP Integration Settings > HP Operations Manager Integration
Settings, and clear theSend events check box. Status change is only applicable onmetrics that are
configured in themonitor's Threshold Setting.

l To disable sending events for an alert, in the New/Edit Alert dialog box, expand the HP Operations
Manager Integration Settings panel, and clear theSend events check box.

Note: TheSend events option is selected by default when event integration is enabled in the
HP Operations Manager IntegrationMain Settings panel (otherwise this option is not available).

13. Configure event mappings for monitors and alerts - optional
Monitor instances and alerts are assigned a common event mapping that is used when an event is
triggered. This is themapping between SiteScope runtime data and the values of the attributes of the
event that will be sent.

You can use the default event mapping associated with themonitor or alert, select a different event
mapping (if any exist), or create a new event mapping inPreferences > Common Event Mappings.
Alternatively, for alerts, you can use the event mapping template associated with themonitor that
triggered the alert.

You can select the event mapping template:

l When configuring amonitor instance from themonitorProperties tab > Event Mapping Settings.

l When configuring alerts from theAlerts tab > New/Edit Alert > HP Operations Manager
Integration Settings > Event mapping.

For details on configuring Common Event Mappings, see "How to Configure Common Event Mappings
for HPOM or BSM" on page 40.

14. Results
After amonitor metric status change or an alert is triggered in SiteScope, the event is written to the
integration log file in the format selected for themonitor instance or alert in Common Event Mappings.
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The agent monitors the log file and creates an event, which it sends to HPOM or BSM. Events are
displayed in the Event Console in HPOM, or in BSM in the Operations Management Event Browser (if
you have an Event Management Foundation license). If Operations Management is not part of your BSM
installation, you can view events that affect CI status using a health indicator in Service Health.

For notes and limitations on event integrations, see "Notes and Limitations" on page 58.

For troubleshooting event integration issues, see "Troubleshooting Event Integration Issues" on page 58.
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Chapter 6: How to Reconnect the Operations
Agent to a Different HPOM or BSM Server
You can reconnect the Operations Agent to a different HPOMmanagement or BSM server by either:

l Uninstalling and reinstalling the Operations Agent.

l Redirecting the Operations Agent to a different server.

Note: This task is part of a higher-level task. For details, see "How to Enable SiteScope to Send
Events to HPOM or Operations Management" on page 19.

To uninstall and reinstall the HP Operations agent:
1. In SiteScope, select Preferences > Integration Preferences, and delete the Operations Manager

integration.

2. In the Control Panel, select Add or Remove Programs orPrograms and Features, and uninstall HP
Operations Agent.

3. Install Operations Agent 11.14 which is available from the root directory of the SiteScope releasemedia.
For details, see "How to Enable SiteScope to Send Events to HPOM or OMi" on page 1.

4. Configure the Operations Agent using the SiteScope Configuration Tool. For details, see the
Configuration Tool section of the SiteScope Deployment Guide (available from the HPE Software
Support site).

5. In SiteScope, configure the Operations Manager integration with the new HPOM/BSM server to which
you want to connect. For details, see "Configure the agent connection settings on the SiteScope server"
on page 23.

Note: After reconnecting to the HPOM server, it can take some time until events are sent to HPOM.
Restarting the HPOM server, the Operations Agent, or both, might fix it.

To redirect the Operations Agent to a different server:

Note: If you are cloning amachine with anOperations Agent which usually includes a host name and IP
address change, start from step 1 below; otherwise start from step 4.

1. To remove the certificates, run:

ovcert -list

For all IDs in the output, run the command:

ovcert -remove 'id'

2. Adapt the xpl configuration variable OPC_NODENAME by running the command:

ovconfchg -ns eaagt -set OPC_NODENAME 'hostname'
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3. Set the new server host name and core ID by running the commands:

ovconfchg -ns sec.cm.client -set CERTIFICATE_SERVER <new OM server>

ovconfchg -ns sec.core.auth -set MANAGER <new OM server>

ovconfchg -ns sec.core.auth -set MANAGER_ID <new OM server ovcoreid>

Tip: To get the ovcoreid for MANAGER_ID in a distributed installation, run the command:

ovcert -list -ovrg server

ovconfchg -ns eaagt.lic.mgrs -set general_licmgr <new OM server>

ovconfchg -ns sec.cm.certificates -set CERT_INSTALLED FALSE

ovcoreid -show

4. Restart the Operations Agent by running the commands:

ovc -kill
ovc -start

5. Create a new certificate request by running the command:

ovcert -certreq

6. Grant a certificate request on the HPOM or BSMGateway Server (in case of distributed BSM, grant
certificate request on the Data Processing Server).

7. In SiteScope, open theOperations Manager Integration dialog box and perform the following in theHP
Operations Manager Integration Main Settings panel:

l Change the name or IP address of the HPOM/BSM server in theHP Operations Manager / BSM
server box. For details, see "Configure the agent connection settings on the SiteScope server" on
page 23.

l Install the log policies by clicking the Install Policies button.

Note: After reconnecting to the HPOM server, it can take some time until events are sent to HPOM.
Restarting the HPOM server, the Operations Agent, or both, might fix it.
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Chapter 7: How to Enable the Drill Down to
SiteScope Tool on HPOM for Windows
This task describes how to enable the Drill Down to SiteScope tool on the HPOM forWindows management
server. This tool enables you to open the SiteScope user interface from themonitor or group service that was
discovered by themonitor discovery policy and added to the HPOM Service Navigator.

Note: This task is part of a higher-level task. For details, see "How to Enable SiteScope to Send Events
to HPOM or Operations Management" on page 19.

1. Prerequisites
TheMonitor Discovery policy must be enabled and deployed on the SiteScope Server node on HPOM.

For task details, see "How to Enable the SiteScopeMonitor Discovery Policy" on page 36.

2. Install the Drill Down to SiteScope tool on the HPOM for Windows server
a. Log on to the HPOM forWindows server machine as an Administrator.

b. Copy the drillDownToSiteScope.vbs file from the
<SiteScope root>\tools\OMIntegration\DrillDownTool\ForOMW folder to
\\<HPOM server>\SPI-Share\SiteScope.

c. Upload the Drill Down to SiteScope tool to the HPOM server:

o Copy the tls_drillDownToSIS.mof file from the
<SiteScope root>\tools\OMIntegration\DrillDownTool\ForOMW folder to any folder on the
HPOM server machine (<tls path>).

o Open a command line and run the command:

>> ovpmutil cfg tls upl <tls path>\tls_drillDownToSIS.mof

d. The Drill Down to SiteScope tool is available on the HPOM server under Tools > SiteScope Tools.

3. Associate the tool with the SiteScope Service
a. In the HPOM forWindows console, open the Service Type Configuration Editor, select Application

Services > SiteScope, and click Properties.

b. In the SiteScope Properties dialog box, click the Tools tab, select SiteScope Tools, and then click
OK.

4. Launch the tool (from the SiteScope service)
a. In the HPOM forWindows console, right-click the SiteScope service that you want to view

(SiteScopemonitor, group, or server service), and select All Tasks > Launch Tool.

b. Select theDrill Down to SiteScope tool, and click Launch.

c. The SiteScope user interface opens displaying the selectedmonitor, group, or the default Dashboard
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view (if SiteScope Server service was selected).

5. Launch the tool (from the Tools repository)
a. In the HPOM forWindows console, expand Tools > SiteScope Tools. In the right pane, right-click

theDrill Down to SiteScope tool and select All Tasks > Launch Tool.

b. In the Edit Parameters dialog box, select themonitor, group, or SiteScope Server service that you
want to view, and click Launch.

c. The SiteScope user interface opens displaying the selectedmonitor, group, or default Dashboard
view (if SiteScope Server service was selected).
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Chapter 8: How to Enable the Drill Down to
SiteScope Tool on HPOM for
UNIX/Linux/Solaris
This task describes how to enable the Drill Down to SiteScope tools on the HPOM for UNIX/Linux/Solaris
management server. This tool enables you to open the SiteScope user interface from events or from the
monitor or group service that was discovered by themonitor discovery policy and added to the HPOM Service
Navigator.

Note: This task is part of a higher-level task. For details, see "How to Enable SiteScope to Send Events
to HPOM or Operations Management" on page 19.

1. Prerequisites
TheMonitor Discovery policy must be enabled and deployed on the SiteScope Server node on HPOM.

For task details, see "How to Enable the SiteScopeMonitor Discovery Policy" on page 36.

2. Install the Drill Down to SiteScope tools on the HPOM for UNIX/Linux/Solaris
server
a. Log on to the HPOM for UNIX/Linux/Solaris server machine as an Administrator.

b. Open a command shell and create a new directory by typing:

# mkdir -p /opt/OV/newconfig/SiteScope

c. Change to the SiteScope directory by typing:

cd /opt/OV/newconfig/SiteScope

d. Copy theDrillDownToSIS.tar file from the
<SiteScope root>\tools\OMIntegration\DrillDownTool\ForOMX folder to
/opt/OV/newconfig/SiteScope on the HPOM server machine.

e. Extract the .tar file to the current directory by typing:

# cd /opt/OV/newconfig/SiteScope

# tar -xvf DrillDownToSIS.tar

f. Upload the Drill Down to SiteScope tools to the HPOM server by typing:

# cd /opt/OV/bin/OpC/

# opccfgupld -replace -subentity /opt/OV/newconfig/SiteScope/ DrillDownToSIS

g. The Drill Down to SiteScope tools are available on the HPOM Administrator user interface under
Browse > All Tool Groups.

h. AssignDrill Down to SiteScope tools to the opc_adm user.
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o Click Action > Assign to User/Profile...

o Select All Users > opc_adm and click OK.

i. Update the HPOM user interface by selecting File > Reload Configuration.

j. The Drill Down to SiteScope tools are available on the HPOM server under Tools > Drill Down to
SiteScope tools.

3. Launch the tool (from the SiteScope service)
a. In the HPOM Administrator user interface, right-click the SiteScope service (server, group, or

monitor), select Start > Tools > Drill Down to SiteScope tools > Drill Down to SiteScope
service, and select the tool according to the service type selected.

b. The SiteScope user interface opens displaying the selectedmonitor, group, or default SiteScope
Dashboard view.

4. Launch the tool (from an event)
a. In the HPOM Administrator user interface, right-click an event and select Start > Drill Down to

SiteScope tools > Drill Down to SiteScope event.

b. The SiteScope user interface opens displaying the selectedmonitor that send the event.
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Chapter 9: How to Enable the SiteScope
Monitor Discovery Policy
This task describes how to enhance the SiteScope integration with HPOM by enabling HPOM Service
Navigator to view SiteScope groups andmonitors in HPOM servicemaps.

Note:

l This task is part of a higher-level task. For details, see "How to Enable SiteScope to Send Events to
HPOM or Operations Management" on page 19.

l HPOM 9.0 forWindows 64-bit consoles support the services tree view with patch OMW_00132 or
later.

1. Copy policy files to the instrumentation folder
On the SiteScope server:

l ForWindows: Copy the discoverSiteScope.bat file from the <SiteScope root
directory>\integrations\om\bin folder to the%OvDataDir%\bin\instrumentation folder.

l For Linux, UNIX, Solaris: Copy all files from /opt/HP/SiteScope/integrations/om/bin/* to the
/var/opt/OV/bin/instrumentation folder.

Note: All relevant policy files can be found in the
<SiteScope root directory>\tools\OMIntegration\
SiteScopeMonitorDiscoveryPolicy\SiS_Discovery_policy_3.0 folder.

2. Upload the policy to the HPOM server (for HPOM for Windows servers)
Prerequisites:

l HPOM forWindows 8.16 (or an equivalent patched 8.10 server) or 9.10, and sufficient user rights
(typically, Administrator).

l All uploads are performed using the HPOM forWindows command line tool ovpmutil which is
normally in the environment path.

To upload the policy to the HPOM server:

a. Open a command prompt, and navigate to the folder where the SiteScope Discovery 3.0 server
components are located. For example, C:\temp\SiS_Discovery_3.0:

cd C:\temp\SiS_Discovery_3.0\ForServer

b. Upload the ServiceModel using ovpmutil:

ovpmutil cfg svt upl .\DiscoverSiteScope.mof
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The ServiceModel is displayed in the HPOM Service Type Configuration Editor (underApplication
Services > SiteScope).

c. Upload the SiteScopemonitor discovery policy using ovpmutil and the provided index file:

ovpmutil cfg pol upl .\PolicyConfig_77BFF2F6-38BD-45B3-BEA9-E237C55F7877.xml

The policy is now available in the HPOM server policy repository underPolicy management >
Policy groups.

3. Upload the policy to the HPOM server (for HPOM for Linux, UNIX, Solaris 9.x
servers)
a. Upload the HPOM ServiceModel to the HPOMmanagement server. Open a command shell and

type:

/opt/OV/bin/OpC/utils/mof_cfgupld.sh /opt/HP/SiteScope/tools/\

SiS_Discovery_policy_3.0/ForServer/DiscoverSiteScope.mof

OMIntegration/SiteScopeMonitorDiscoveryPolicy/\

(The .mof file is located in the <SiteScope>/tools/OMIntegration/
SiteScopeMonitorDiscoveryPolicy/SiS_Discovery_policy_3.0/ForServer folder.)

b. Upload the policies by typing in a command shell:

/opt/OV/bin/OpC/utils/opcpolicy -upload dir=/opt/HP/SiteScope/\

tools/OMIntegration/SiteScopeMonitorDiscoveryPolicy/\

SiS_Discovery_policy_3.0/ForServer

c. Assign the policies to the node, and deploy to the SiteScope node by typing in a command shell:

# /opt/OV/bin/OpC/utils/opcnode -assign_pol node_name=<NODENAME> net_
type=NETWORK_IP pol_name= "SiteScope Discovery" pol_type=svcdisc

4. Set the Schedule Interval
You can set the schedule interval for running the SiteScopemonitor discovery policy on the HPOM agent
in the HPOM forWindows console.

a. Select Policy management > Policy groups > SiteScope Discovery. In the right pane, right-click
SiteScope Discovery and select All Tasks > Edit.

b. In the Service Auto-Discovery policy editor, select theSchedule tab and specify an interval for
running the SiteScopemonitor discovery policy on the HPOM agent in the HPOM forWindows
console.

By default, the SiteScopemonitor discovery policy runs every 5minutes. You can change this frequency

5. Deploy the policy
Prerequisites:

l TheOperations Agent is running and connected (for details, see "How to Enable SiteScope to Send
Events to HPOM or Operations Management" on page 19).
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l The SiteScope server to be integrated is set up as an HPOMmanaged node, and a certificate has
been granted. For details, see "Accept the agent connection request on the HPOMmanagement
server or BSMGateway/Web Processing server" on page 24.

l The SiteScopemonitor discovery policy has been uploaded to the SiteScope Discovery policy
group (for details, see "Upload the policy to the HPOM server (for HPOM forWindows servers)" on
page 36 or "Upload the policy to the HPOM server (for HPOM for Linux, UNIX, Solaris 9.x servers)"
on the previous page).

To deploy the policy for HPOM for Linux, UNIX, Solaris 9.x servers:

Open a command shell and type: # opcragt -dist <NODENAME>

To deploy the policy for HPOM for Windows servers:

a. Right-click theSiteScope Discovery policy and select All Tasks > Deploy on.

b. In the Deploy Policies on dialog box, select the SiteScope Server OM node from the available
managed nodes, and click OK. The deployment status is displayed inDeployment jobs in the OM
Console.

c. To view the policy inventory of the node, right-click the SiteScope Server OM node underNodes,
and select View > Policy Inventory.

d. The policy inventory is displayed in the right pane, showing all policies deployed to the node.

6. Update Discovery Policies when SiteScope uses SSL
When discovery policies are activated and SiteScope uses an SSL connection, you need to update the
policies batch file with the trust store password and keystore password and run the policy again.

a. Open <SiteScope root directory>\integrations\om\bin\run_api_call_om.bat in a text editor and
replace the line:

%JAVA_LOCATION%\java.exe -Xmx512M -classpath %CLASS_PATH% %*

With this one (enter the values of clientTrustStore_path, clientKeystore_path,
trustStorePass, and keyStorePass):

%JAVA_LOCATION%\java.exe -Xmx512M
-Djavax.net.ssl.keyStore=%clientKeystore_path%/clientKeystore
-Djavax.net.ssl.keyStorePassword=$keyStorePass
-Djavax.net.ssl.trustStore=%clientTrustStore_path%/clientTrustStore
-Djavax.net.ssl.trustStorePassword=$trustStorePass
-classpath %CLASS_PATH% %*

b. Run the policy again.

7. Manually run the Monitor Discovery policy - optional
For testing or debugging purposes, it is useful to run the discovery manually. This can be done using the
ovagtrep command line tool on the SiteScope server HPOM agent node where the policy is running.

To do so, run the following commands:
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a. To force execution of the policy, run the command:

ovagtrep -run "SiteScope Discovery"

b. To force submittal to server, run the command:

ovagtrep -publish

c. For troubleshooting, use theSystem.txt file in the%OvDataDir%\log folder.

8. Drill down to the SiteScope user interface from HPOM - optional
You can also use the Drill Down to SiteScope tool to enable opening the SiteScope user interface from
themonitor or group service that was discovered by themonitor discovery policy and added to the HPOM
Service Navigator.

For details on enabling the tool for HPOM forWindows, see "How to Enable the Drill Down to SiteScope
Tool on HPOM forWindows" on page 32.

For details on enabling the tool for HPOM for UNIX/Linux/Solaris, see "How to Enable the Drill Down to
SiteScope Tool on HPOM for UNIX/Linux/Solaris" on page 34.

9. Troubleshooting
l You can check the following files:

o System.txt file in the <SiteScope Server>\%OvDataDir%\log folder (for Linux: <SiteScope
Server>/var/opt/OV/log).

o agtrep.xml file in <SiteScope Server>\%OvDataDir%\datafiles folder (for Linux: <SiteScope
Server>/var/opt/OV/datafile) to see the discovered instances the agent knows about.

o <HPOM Server>\%OvShareDir%\server\log\OvSvcDiscServer.log to see what the HPOM
server receives.

l See "Node Discovery andMonitor Discovery Troubleshooting" on page 64.
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Chapter 10: How to Configure Common Event
Mappings for HPOM or BSM
This task describes how to use Common Event Mappings to configure event mappings for monitors and
alerts. This is themapping between SiteScope runtime data and the values of event attributes that will be
sent.

1. Prerequisites
l To create or make changes to event mappings, youmust be a SiteScope administrator user, or a user
grantedAdd, edit or delete common event mappings permissions. For details on user
permissions, see the section on user management preferences in the Using SiteScopeGuide in the
SiteScope Help.

l To select an event mapping when configuring an alert or amonitor instance:

o TheOperations Agent must be installed and connected to an HPOM or BSM server. For details,
see How to Enable SiteScope to Send Events to HPOM or Operations Management.

o Event integrationmust be enabled in the Operations Manager Integration dialog box (In
Preferences > Integration Preferences > HP Operations Manager Integration. For details,
see "Enable SiteScope to send events to HPOM or Operations Management" on page 26.

2. Configure the alerts or monitor instances
You configure the alerts or monitor instances that, where triggered, create the relevant events in the
event system.

For task details, see the alerts or monitors section in the Using SiteScopeGuide in the SiteScope Help.

3. Configure the event mappings for an alert or monitor instance
You configure an event mapping tomap an alert or monitor instance to the corresponding event
attributes. You can create several mappings for each type of alert or monitor.

l You configure alerts from theAlerts tab > New/Edit Alert > HP Operations Manager Integration
Settings > Event mapping.

l You configure amonitor instance frommonitorProperties tab > Event Mapping Settings.

For each alert or monitor instance, you can use the default event mapping associated with themonitor or
alert, select a different event mapping (if any exist), or create a new event mapping in Common Event
Mappings. Alternatively, for alerts, you can use the event mapping template associated with themonitor
that triggered the alert.

To create or edit a mapping:
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a. In the New/Edit Event Mappings dialog box, click theNew Event Mapping button, or select an

existing event and click theEdit Event Mapping button.

b. In theMain Settings panel, enter a name to identify the common event and a description.

c. In theCommon Event Model Settings - General tab, you can use the default settings, or edit them
as necessary. For details, see "Common Event Model Settings - General Tab" on page 52.

d. Use theCommon Event Model Settings - Custom Attributes tab to add attributes which provide
additional information about the event that is not provided in any of the other common event
attributes. A custom attribute consists of a key and a value (both are strings). The value can be any
string and is used by the common event mapping as any other value. For details, see "Common
Event Model Settings - Custom Attributes Tab" on page 56.

4. Results
You can view the events corresponding to the triggered alerts or changes in amonitor's metric status in
the Event Console in HPOM, or in Operations Management in BSM (if you have an Event Management
Foundation license).

If Operations Management is not part of your BSM installation, you can view events that affect CI status
using a health indicator in Service Health.

For troubleshooting relating to the HP Operations agent installation, event integration setup, sending
events, and with node andmonitor discovery, see "Troubleshooting Event Integration Issues" on
page 58.
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Chapter 11: Properties Available in Alerts,
Templates, and Events
The following properties can be found or used in SiteScope alerts, alert and email templates, and common
event mappings for sending events to management consoles.

This section includes:

l "Alerts, Alert Template, and Event Properties" below

l "Common Event Template Properties" on page 49

l "Microsoft Windows Event LogMonitor Properties" on page 50

l "Email Report Properties" on page 50

Alerts, Alert Template, and Event Properties

The following is a list of the common properties found in SiteScope alerts, alert templates, and attributes used
in common event mappings (for monitor and alert events).

Note:

l Attributes in event mappings have an additional left ("<") and right (">") angle bracket which is not
shown in the table below.

l a indicates whether properties can be used in alerts and/or common event mappings (associated
with amonitor or an alert).

l Where properties are included in specific alert templates, the relevant templates are listed in the
Included in Alert Template column.

Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<alertHelpURL> URL of the SiteScope help including the alert topic. NoDetails

Traceroute

WithDiagnostic

a a a

<alert::name> The name of the alert. a

<alert::id> The alert ID. a

<alert::description> Text description for the alert definition. a

<alert::disable
Description>

Description of the purpose of the disable
operation.

a

<alert::actionID> The ID for the alert action. a

<alert::actionName> The name of the alert action. a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<all> All of the properties of themonitor. a a a

<allThresholds> Returnsall the thresholds in themonitor in the
email alert.

a a a

<analyticsResults> Showsa summaryof analytics results, which
includes:

l Name of analyzedmonitor and name of
analytics object.

l All correlation results or top 500 best fitting
onesper analyzed (source) monitor metric.

l For an alert triggered bya static threshold:
metrics that are in the status for which the alert
was triggered.

l For an alert triggered byAnalytics: metrics of
themonitor which are out of the baseline
sleeve.

AnalyticsMail

<bacMonitorID> Themonitor'sBSM ID. a

<bacSessionID> The BSM profileID. a

<category> Themonitor category. Typical a a a

<changedToErrorOnly> Showsonly themetrics that have changed to error
status.

a a a

<changedToWarningOnly> Showsonly themetrics that have changed to
warning status.

a a a

<changedToGoodOnly> Showsonly themetrics that have changed to good
status.

a a a

<classifier>
(or _<classifier>)

Returns the first threshold in themonitor in the
email alert.

a a a

<currentTime> The time that the alert is run. a a a

<customerId> Customer ID for SAASenvironment a a a

<_description> Displays the description entered in theReport
description field of themonitor'sGeneral
Settings that makes it easier to understand what
themonitor does. This description is displayed on
each bar chart and graph inManagement
Reports.

a a a

<diagnosticText> Calculatesa string from other properties that the
monitor is able to return. The translation can be
different for different typesof monitors because
everymonitor can choose a different value
combination for this property.

Default User

NoDetails

WithDiagnostic

a a a

<diagnosticTrace
Route>

This tag is filled only for warning and error
conditionswhen the Traceroute Email template is
used with the URLContent monitor.

Traceroute

WithDiagnostic

a a a

<errorCounterOnly> List of themonitor counters in error status (returns
counter name only).

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<errorOnly> List of themonitor counters in error status (returns
counter name and counter value).

Typical a a a

<firstgroupdescription> Partial group description. Only the first description
from several different ones.

a a a

<fullgroupdescription> Full group’s description. a a a

<FullGroupId> Full path from the SiteScope root directory to the
group, exclude\SiteScope.

a a a

<fullMonitorName> Full path from the SiteScope root directory to the
monitor. For example,
\SiteScope\MyGroup\MyCPUMonitor.

a a a

<goodCounterOnly> List of themonitor counters in good status (returns
counter name only).

Typical a a a

<goodOnly> List of themonitor counters that are in good status. Typical a a a

<group> Name of the group in which themonitor is located. AllErrors

AnalyticsMail

Default

Default User

lr-Default_mail_
template

NoDetails

NTEventlogt

PagerMail

ShortMail

Traceroute

Typical

WithDiagnostic

XMLMail

a a a

<groupdescription> Full group’s description and group’s parent
description.

a a a

<groupID> ID of the group. Default

Typical

WithDiagnostic

XMLMail

a a a

<group.propertyname> Property of the group in which themonitor is
located. Group properties that can be used in the
tags include: _externalId, _
dependsCondition, _name, and _topazId.

a a a

<group.parent.
propertyname>

Property of the parent group of the group in which
themonitor is located. Group properties that can
be used in the tags include: _externalId, _
dependsCondition, _name, and _topazId.

a

<_httpPort> Port number used to accessSiteScope (as in
EmailReport Properties)

NTEventlog a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<id> Current monitor’s ID number. It identifies the
monitor within the group

XMLMail a a a

<mainParameters> List of themainmonitor properties that are set as
parameter.

Default

Default User

NTEventlog

WithDiagnostic

a a a

<mainStateProperties> List of mainmonitor properties that are set as state
properties. These are the result statistics that are
shown on the Reports.

Default

Default User

NTEventlog

WithDiagnostic

a a a

<matchedLine> Use for Multi Logmonitor when the "For each log
entrymatched" option is selected inRun alerts.
When this property is used, themonitor status
displays the whole line instead of just thematched
content and the file where it was found.

a

<monitorClass> Themonitor’s classname. a a

<monitorDrilldownUrl> Createsa hyperlink in the event to themonitor
URL.

a a a

<monitorDrilldown
Url
Secured>

Createsa hyperlink in the event to themonitor
URLwithout login information in the link itself.

a a a

<_monitorDescription> Displays the description of themonitor entered in
theMonitor description field of themonitor's
GeneralSettings.

a a a

<monitorName> Name of themonitor.

(same as "<name>")

a a a

<<monitorServiceId>> Enables customizing the service name that is sent
from SiteScope events to HPOMbyentering the
value of themonitor service ID. This is useful for
relating the SiteScopemonitor with the HPOM
Service Name.

a a a

<monitorType> The type of monitor, such asCPU. a a a

<monitorTypeDisplay
Name>

TheMonitor’s classTopazname a a a

<monitorUUID> Monitor’sUUID a a a

<mountName> Returnsmount names. This is applicable when
monitoring remote UNIX serverswhile using the
DynamicDiskSpacemonitor.

a a a

<multiViewUrl> Createsa hyperlink to the SiteScopeMulti-View
URL.

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<name> Name of themonitor.

(same as "<monitorName>")

AnalyticsMail

Default

Default User

lr-Default_mail_
template

NoDetails

NTEventlog

PagerMail

ShortestMail

ShortMail

ShortSubject

Traceroute

Typical

WithDiagnostic

XMLMail

a a a

<newSiteScopeURL> URL of the SiteScope server. Default

Typical

a a a

<processtext> ProcessStats, only relevant if the object hasa
machine.

a a a

<remoteMachineName> Displays the name of the configured remote server
used by themonitor.

a a a

<sample> Sample # AllErrors

AnalyticsMail

Default

Default User

NoDetails

NTEventlog

PagerMail

ShortMail

Traceroute

Typical

Typical.mail

WithDiagnostic

XMLMail

a a a

<sitescopeurl> URL of the SiteScope server with extra account
information.

a a a

<siteScopeBaseUrl> URL of the SiteScope server in a different format. a a a

<siteScopeHost> URL of the SiteScope host name. a a a

<secondaryParameters> Lists themain state properties and other internal
properties.

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<secondaryState
Properties>

Lists themain state properties and other internal
properties.

a a a

<sitescopeURL> TheURL to themain page of SiteScope for admin
access.

AllErrors

Default User

NoDetails

Traceroute

WithDiagnostic

a a a

<sitescopeuserurl> The URL to themain page of SiteScope for user
access.

a a a

<state> Status string reported by themonitor.

(same asstateString)

AllErrors

AnalyticsMail

Default

Default User

lr-Default_mail_
template

NoDetails

PagerMail

ShortestMail

ShortMail

ShortSubject

Traceroute

Typical

WithDiagnostic

XMLMail

a a a

<tag> Tagsof themonitor (if exists). AnalyticsMail

Default

Default User

lr-Default_mail_
template

NoDetails

NTEventlog

PagerMail

ShortestMail

ShortMail

ShortSubject

Traceroute

Typical

WithDiagnostic

XMLMail

a a a
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Available
Properties Description

Included in
Alert Templates Alerts

Events

Monitor Alert

<tag:[tagName]> Displays the value or valuesof the Search/Filter
tag with the [tagName] assigned to themonitor
that triggered the alert.

Example: You have a tag named AppServerwith
value Apache assigned to amonitor, and you
include <tag:AppServer> in the alert template
configured for that monitor. If an alert is triggered,
the new property is replaced with Apache in the
alert text.

a a a

<targetHost> Name of the target host. a a a

<targetIP> IP of the target host. a a a

<targetIPAsHEX> IP of the target host in HEX fomat. a a a

<targetIPVersion> Retrievesmonitor host IP version (IPV6 or IPV4). a a a

<templateDeployPath> Displays the path of the template group fromwhich
themonitor wasdeployed.

a a a

<time> Time that themonitor completed the last run. AllErrors

AnalyticsMail

Default

Default User

lr-Default_mail_
template

NoDetails

NTEventlog

Traceroute

Typical

WithDiagnostic

XMLMail

a a a

<time-date> The date portion of the time that themonitor
completed.

a a a

<time-time> The time portion of the time that themonitor
completed.

a a a

<warningCounterOnly> List of themonitor counters in warning status
(returns counter name only).

a a a

<warningOnly> List of themonitor counters in warning status
(returns counter name and counter value).

Typical a a a

<unifiedConsoleUrl> Opens theOpsView in the Unified Console, which
displaysMulti-View and the Event Console.

a a

<_webserverAddress> IP address for the SiteScope Server (as in Email
Report Properties)

NTEventlog a a a
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Common Event Template Properties

The followingmetric specific properties are resolved from themonitor‘s counter data and should be used in the
Common Event Template for monitor events only.

These properties are relevant for monitor events because they are triggered by a specific metric change. They
are not relevant for alert events because they are triggered by a status change, which is a single state that can
be resolved from several metric changes.

Available Properties Description

<metric> The name of the counter that triggered the alert.

<metricValue> The ETI value associated with the threshold that has been crossed.

<newStatus> Current status of themetric.

<oldStatus> Previous status of themetric.

<etiValue> The ETI value associated with the threshold that has been crossed.

<etiType> The ETI type associated with the counter that crossed the threshold that created
the event.

<thresholdCrossed> The display name of the threshold setting that was crossed.

<thresholdCrossedFull> The full string representation of the threshold setting that was crossed. It also
contains the ETI value and the status associated with this threshold, which
uniquely identifies the threshold.

<severity> Severity of the occurrence that the event relates to.

<ciHint> Information about the CI that is related to the event. This attribute is for providing
one or several hints that enables the event processing to find the correct "related
CI".
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Available Properties Description

<subCiHint> Information used to identify a subcomponent of a CI. This CI subcomponent is
used to calculate an aggregated status within BSM's Service Health for selected
CIs.

If an HI is populated by events frommultiple components, you can specify a
component name in this field in order to ensure the correct calculation of the HI
state.

Example: If you have a Computer CI with two CPUs, cpu #1 and cpu #2, events
from both CPUs will be sent to the sameCPU Load HI. By default, the events
will overide each other and create an incorrect HI state. To prevent this, you can
populate ComponentCi with values "cpu #1" and "cpu #2" which will cause the
HI state to be calculated as an aggregated state between the two events.

<alertName> The name of the alert.

Microsoft Windows Event Log Monitor Properties

The following properties can only be used in theMicrosoft Windows Event Logmonitor. They can be used in
SiteScope alerts, alert templates, and common event mappings (monitors and alerts).

Available Properties Included in Templates

<eventCategory> NTEventlog

<eventID> NTEventlog

<eventMachine> NTEventlog

<eventSource> NTEventlog

<eventType> NTEventlog

Email Report Properties

The following properties are applicable to the email templates stored in the <SiteScope>\templates.history
directory:

Available Properties Description

_httpPort Port number used to access SiteScope

_webserverAddress IP address for the SiteScope Server

basicAlertSummary Basic information on what alerts have been triggered

Integration with HP Operations Manager Products
Chapter 11: Properties Available in Alerts, Templates, and Events

HPE SiteScope (11.32) Page 50 of 88



Available Properties Description

detailAlert Summary More detailed information on alerts

reportIndexURL URL to the index page for themanagement report

reportPeriod Time period for this report

reportURL URL to the HTML version of themanagement report

summary Summary andmeasurement information

textReportURL URL to the comma-delimited file generated by SiteScope

userReportIndexURL URL to the index page for a user-accessible report

userTextReportURL URL to the comma-delimited file generated by a user-accessible report

userXMLReportURL URL to the XML file generated by a user-accessible report

xmlReportURL URL to the XML file generated by themanagement report
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Chapter 12: Common Event Mappings User
Interface
The New/Edit Event Mappings dialog box enables you to create new common event mappings or edit existing
mappings. These aremappings between SiteScope runtime data and the attribute values that are used for
sending events. Common event mappings are used when configuring the Operations Manager event
integration and theGeneric Event integration.

This section includes:

l "Common Event Model Settings - General Tab" below

l "Common Event Model Settings - Custom Attributes Tab" on page 56

Common Event Model Settings - General Tab
User interface elements are described below:

UI Element Description

General

Title Descriptive text describing the occurrence represented by the event. This should include
information about what threshold has been crossed (or other trigger conditions), and the
current values.

Default value:

l Formetric status change:
Metric '<<metric>>' changed status from '<<oldStatus>>' to '<<newStatus>>'

l For alerts:
Alert '<<alertName>>' was fired onmonitor '<<fullMonitorName>>' status change

Tip:Since the text is typically shownwithin a single line in the event browser, it is
recommended to put themost relevant information at the beginning.

Description Additional information describing the event.

Default value:

l Formetric status change:
Metric '<<metric>>' crossed '<<thresholdCrossed>>' with value '<<metricValue>>'

l For alerts:
Monitor '<<fullMonitorName>>' changed status from '<<oldStatus>>' to
'<<newStatus>>'
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UI Element Description

Severity Severity of the occurrence related to the event. The severity level can be Unknown,
Normal, Warning, Minor, Major, or Critical.

Default value: <<severity>>. The <<severity>> attribute is replaced by the severity in the
Indicator State and Severity field in the Threshold Settings for the selectedmonitor
metric.

Category Value used for organizing or grouping events by monitor type.

Default value: <<monitorType>>

Examples:Database, Application, J2EE

Subcategory Value used for organizing or grouping events that have the same category.

Default value:

l Formetric status change: <<metric>>

l For alerts: <<fullMonitorName>>

Example:Oracle

Log only If True is selected, enables submitting an event that goes directly into the history event
browser as a closed event. Such an event goes through the complete event processing, but
has its Life Cycle State set to close from the beginning.

Typical examples are events that result in resetting an indicator to a normal or good state,
or an event signaling that a previous problem no longer exists (where the problem was
reported in another event).

If True for normal severity is selected, all messages forwarded from SiteScope to HPOM
are sent to theAcknowledgedmessage browser (instead of theActivemessage browser)
if their severity is normal. This prevents theActivemessage browser becoming
unnecessarily cluttered with normal severity messages.

Default value: False

Event Type
Indicator

Link between the event and the indicator so that information about the indicator can be
updated as a result of submitting the event.

Default value:

l Formetric status change: <<etiType>>:<<etiValue>>:<<metricValue>>

l For alerts: <<etiType>>:<<etiValue>>

Example of metric status change: CPU Load:High:90

Note: This field is mandatory for updating the indicator. It is recommended not to change
the template value of this attribute.
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UI Element Description

Correlation

Key A unique string representing the type of event that occurred. Two events can have the
same key if both events represent the same situation in themanaged environment.
Duplicate events are discarded after the number of duplicate events is increased in the
"Number of Duplicates" count.

Default value:

l Formetric status change:
<<siteScopeHost>>:<<monitorUUID>>:<<metric>>:<<etiValue>>:
<<severity>>

l For alerts:
<<siteScopeHost>>:<<monitorUUID>>:<<alertName>>:<<etiValue>>

Example of metric status change:

labmachine1:OMEventIntegration:CPU Utilization on SiteScope Server:
utilization:Good

Submit
close key
condition

Enables the close key pattern to be evaluated by the event subsystem. If selected, enter
the pattern in theClose key pattern box below.

Default value:Selected

Close key
pattern

(This box is available only if Submit close key condition is selected.) Enables the event
that is sent to automatically close all the events whose key attributematches this
expression. It is recommended that this field contain the same value as in the Key field.

Note:SiteScope event integration policy always adds "<*>" to the end of your close key
pattern. The "<" and ">" signs cannot be used here since that they cannot be interpreted by
the log file policy.

Default value:

l Formetric status change:
<<siteScopeHost>>:<<fullgroupid>>:<<monitorName>>:<<metric>>

l For alerts: <<siteScopeHost>>:<<monitorUUID>>:<<alertName>>

Example: labmachine1:OMEventIntegration:CPU Utilization on SiteScope
Server:utilization<*>

Advanced Parameters
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UI Element Description

CI hint Information about the CI that is related to the event. This attribute is used for providing hints
to enable the event processing to find the correct related CI (RTSM ID of the related CI).

Default value: <<ciHint>>. The value in this field varies, depending on whether SiteScope
is connected to BSM or HPOM. This field is not editable.

Host hint The target host beingmonitored by themonitor that triggered the event. The value is
translated to the legacy node attribute in HPOM. If the node does not exist in HPOM, the
event will be lost.

Default value: <<targetHost>>

Examples:

l IPv4: 15.15.12.13,

l DNS: host1.hp.com

Generating
source hint

Information about themonitoring application and the corresponding probe/agent that is
responsible for creating the event.

Default value:SiteScope@@<<siteScopeHost>>

Example: SiteScope@@host1.hp.com

Attributes

<Attributes
list>

Displays the list of available attribute variables. You can add an attribute by dragging it from
theAttributes list to the selected text box, or select the cell in which to copy the selected
attribute, and click Ctrl+I.

For a description of the available attribute variables, see "Properties Available in Alerts,
Templates, and Events" on page 42.
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Common Event Model Settings - Custom Attributes
Tab
User interface elements are described below

UI Element Description

Enables creating a new custom attribute for the event. Each event can have any number of
custom attributes.

l New Key. Adds a new line to the table, enabling you to add a name and value for the
attribute.

l Known Key. Opens a submenu with the known keys as options. You can select the
relevant key. A new row opens in the Name/Value table, with the name of the selected
key in the Name column. You can then enter the value of the key in the corresponding
Value column.

Delete Custom Attribute. Deletes the selected custom attribute from the table.

Name and
Value

Each event can have any number of custom attributes. Custom attributes can be used to
provide additional information with the event that is not provided in any of the other common
event attributes or that is contained in any of the other attributes. Each custom attribute is a
Name-Value pair, where you enter the name of the attribute in theName field and the value
of the attribute in theValue field.

This featuremay be used when youmanage the environment of multiple customers using
one instance of the product. Themultiple customers might be handled by a custom attribute
object.

Example:Name = "cma1" ; Value = "XYZ Company"

Note:Make sure that the name of the attribute you are defining is unique and does not
already exist in the attributes list.

Attributes
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UI Element Description

<Attributes
list>

Displays the list of available attribute variables. You can add an attribute by dragging it from
theAttributes list to the selected box, or select the cell in which to copy the selected
attribute, and click Ctrl+I.

For a description of the available attribute variables, see "Properties Available in Alerts,
Templates, and Events" on page 42.

HP CDA Event Mapping template

This is an out-of-the-box template that is specially configured for CDA (Continuous Delivery
Automation). CDA is a policy-based platform that provides infrastructure provisioning in
hybrid cloud environments. CDA integrates with SiteScope to deploy SiteScopemonitors
and receive events from them. Monitoring status based on the events received is available in
the CDA user interface. For more details on CDA, refer to the CDA documentation.

The following attributes are included in the Custom Attributes tab for the HP CDA Event
Mapping template which is included by default in Common Event Mappings:

l <<TemplateDeployPath>>. Displays the full path to the template group from which the
monitor was deployed.

l <<monitorServiceId>>. See Service ID below.

l <<monitorDrilldownURL>>. Creates a hyperlink in the event to themonitor URL.

l <<newStatus>>. Current status of themetric.

Service ID Enables customizing the service name that is sent from SiteScope events to HPOM by
entering the value of themonitor service ID. This is useful for relating the SiteScopemonitor
with the HPOM Service Name.

Default value: <<monitorServiceId>>
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Chapter 13: Troubleshooting Event Integration
Issues
This section contains notes and limitations, and provides troubleshooting when using the Operations Manager
integration to send events directly to the HPOMmanagement server or to Operations Management in BSM.

This section includes:

l "Notes and Limitations" below

l "Integration Setup Problems" on the next page

l "Problems Sending Events" on page 62

l "Node Discovery andMonitor Discovery Troubleshooting" on page 64

l "Certificate Requests Do Not Reach theOperations Management Server" on page 65

Notes and Limitations
l Upgrades for SiteScope-HPOM event integrations earlier than SiteScope 11.00 are not supported.

l While SiteScope 10.x versions support HPOM event integration, events generated in SiteScope versions
earlier than 11.00 do not affect Service Health and Service Level Management in BSM 9.0x.

l If SiteScope is installed on the samemachine as HPOM, when uninstalling SiteScope you should also
uninstall the Operations Agent.

l Sending events to HPOM using the Operations Agent is available only when connected to BSM 9.00 or
later. Although the earlier HPOM integration solution of installing the HP SiteScope Adaptor on the HPOM
management server is supported in earlier versions of SiteScope, it is not supported with SiteScope11.00
or later and should be uninstalled. You should therefore upgrade to the implementation using the
Operations Agent.

l If you are having problems activating node discovery or deploying themonitor discovery policy, verify that
the SiteScope node system properties are discovered correctly, and fix them if necessary. In the Node
Properties dialog box, select theSystem tab andmake sure the settings matches you SiteScope node
system settings.

l If you are using Operations Manager forWindows 9, patch OMW_00097/98 or later (32-bit/64-bit) is
required to support the Node discovery feature without overriding SiteScope node properties.

l If you currently use HPOMwith SiteScope and you plan to upgrade HPOM to BSM, youmust connect
SiteScope directly to BSM to perform the upgrade. This also enables SiteScope to report the topology to
BSM. For details on connecting SiteScope to BSM, see section on working with BSM in the Using
SiteScopeGuide in the SiteScope Help..

l When SiteScope sends an event in which amonitor metric value does not match any of the thresholds, the
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indicator severity Normal is sent to the HPOMmanagement/BSMGateway Server.

l When SiteScope is connected to BSM, after amonitor is created on a new host, the event is sent to
Operations Management without the value of the related CI (the event is triggered before topology is
reported to BSM). To avoid waiting for the next event to be sent, select theManually send first event
check box in themonitor's HP Integration Settings > HP Operations Manager Integration Settings.
This action can be performed globally using Global Search and Replace.

l If there are no ETIs from SiteScope in the Operations Management Event Browser, make sure when
configuring event integration that theBSM Service Health affected by setting inHP Integration
Settings > BSM Service Health Preferences is set toEvents. IfMetrics is selected, status change
events reported by SiteScope do not have any influence on CIs in Service Health or Operations
Management.

l Events are not closed (relevant to HPOM and BSM) and the indicator status is not cleared (relevant to
BSM) if SiteScope stops monitoring in the following instances:

l The related SiteScopemonitor skipped or was disabled/suspended (permanently or by the scheduler)

l The related SiteScopemonitor was deleted

l SiteScope stops reporting to BSM (for example, if it is disconnected)

l To exclude indicators of disabledmonitors from Service Health, Service Level Management, or both, it is
recommended to use DowntimeManagement in BSM 9.0x or later. For details, see the section on
downtimemanagement in the BSM Platform Administration Guide in the BSMHelp.

Tip:When referring to the integration log file, you can open it from the SiteScope user interface (Server
Statistics > Log files > HPSiteScopeOperationsManagerIntegration.log).

Integration Setup Problems
Symptom:

Any problem that occurs while trying to configure the Operations Manager Integration (between connecting the
agent to the HPOM/BSM server and sending a test message).

Troubleshooting:

1. In SiteScope, open the HP Operations Manager Integration dialog box panel (Preferences > Integration
Preferences > HP Operations Manager Integration).

2. In the HP Operations Manager IntegrationMain Settings pane, check theHP Operations agent
installation path.

a. Click theResolve Path button.

b. Make sure the agent is installed on the path you see in this field.
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o If the agent is installed on a different path, update the path accordingly.

o If you do not see the path is resolved (probably the agent is not installed properly), try restarting the
server machine. If it does not help, uninstall the Operations Agent and then install it again (it is also
recommended to restart the server).

c. Make sure your HPOMmanagement server or BSMGateway host name is typed correctly in the host
field.

3. Click theAnalyze button.

a. If the command outputs are empty, there is a problem with the agent installation. Uninstall the
Operations Agent and then install it again (it is also recommended to restart the server).

b. Check that the bbcutil command output returns status=eServiceOK. If it does not, there is a
connectivity problem to your HPOMmanagement server.

c. Check the opcagt -status command output. You should see a few processes running (some can be
in Aborted state—this is fine at this stage). If they are not running, manually start the agent by running
command line: opcagt -start, or restart your server machine.

4. Make sure your HPOMmanagement server is up and running.

5. If you are working with BSM, check your Gateway and Data Processing Server:

a. Run command line ovc -status to check the server. Make sure all processes are running (in
particular, the "Certificate Broker"). If they do not start, run command line ovc -start

b. Check the connection from SiteScope to the Gateway Server by running the command: ping
https://<BSM Gateway Server>/com.hp.ov.opc.msgr. If this fails, restart theWDE process on
theGateway Server.

6. If you are working with a distributed BSM environment (in BSM 9.00 or later), follow the procedures for
initiating trust between your Gateway and Data Processing Server, and forwarding the certificate request
from theGateway to the Data Processing Server. For details, see "How to Enable SiteScope to Send
Events to HPOM or Operations Management" on page 19.

7. Click theConnect button, andmake sure the command output returns: opcactivate Info:
Successfully activated OVO agent.

If it does not, contact your HPOM administrator for assistance.

Note: If there is a large time difference (more than 24 hours) between the certificate server and the
Operations Agent, youmight encounter the following error when running agent commands such as
ovc – status, ovc –start, or opcagt -status:

(ctrl-21) Communication error when executing 'Status' method.
(sec.core-113) SSL certificate verification error (The presented peer certificate
is not yet valid.)

This problem occurs because certificates are only valid in the specified time period, and usually
solves itself (after a day) when the certificate becomes valid. The time is specified in Coordinated
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Universal Time (UTC), independent from time zones, and certificates are issued to be valid from 24
hours in the past.

8. Accept the certificate request.

l When connecting to a BSM server, follow the step for accepting the agent connection request in "How
to Enable SiteScope to Send Events to HPOM or Operations Management" on page 19.

l When connecting to an HPOMmanagement server, consult your HPOM administrator. If you do not
see the certificate request, contact your HPOM administrator.

9. Click theAnalyze button.

a. Make sure the ovcert -check is ok, and it ends with "Check Succeeded".

b. Make sure ovcert -list lists some certificates.

c. If there are problems with the command outputs:

o Contact your HPOM administrator, or

o Start the integration process troubleshooting from the connect phase, or even reinstall the agent.

10. Click the Install Policies button.

a. If you get an error here or this process is stuck with "please wait" and:

o You recently reinstalled the agent and did not restart yet, restart your server.

o Otherwise, there is a problem with the agent (and the additional policy activation tool package)
installation. Reinstall on a clean image.

b. Click theAnalyze button, or check the output of the Install Policies for the list of policies. Make sure
you see the following list with all enabled:

o HP_SiteScope_to_Operations_Manager_Integration_by_Log_File

o HP_SiteScope_to_Operations_Manager_Integration

o SiteScope_Hosts_Discovery

11. In the Test Message box, type amessage and click Send test message.

a. Check your HPOM Event Console or Operations Management Event Browser.

b. If you do not see themessage in the Event Console/Browser:

o Run command line: opcmsg a=a o=o msg_t=xxx

o If the command is not available, something went wrong with the process so far (either the
certificate or the policies does not work). Try to install the policies again, and if the same problem
occurs contact HP Software Support.

o If the command is executed but you still do not see themessage in the Event Console, contact
your HPOM administrator for support.
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Problems Sending Events
Symptom 1:

Sending a test event from the HP Operations Manager Integration dialog box does not reach the HPOM Event
Console/Operations Management Event Browser.

Troubleshooting:

1. In the HP Operations Manager Integration dialog box, enter a test message in the Test message box,
and click Send test message. If the test message is not displayed in the Event Console, follow all the
steps in "Integration Setup Problems" on page 59, and then try again.

2. Click theAnalyze button, andmake sure all commands are successful (in particular, see the list of
policies installed). For details, see "Integration Setup Problems" on page 59.

3. Click theSend Test Event button.

4. In the <SiteScope root directory>\logs directory, check the events log file,
HPSiteScopeOperationsManagerIntegration.log. Verify the event entry in the log file. If you do not
see it, contact HP Software Support.

5. If you still do not see the event in the HPOM Event Console/Operations Management Event Browser,
check you are viewing the correct node in HPOM, or are not filtering out anything in the Operations
Management Event Browser. If you still do not see the event, contact HP Software Support.

6. Open the <SiteScope root directory>\tools\OMIntegration\Policies\F516CEC3-3AD4-4627-9CFD-
BB155B894349_data file, and check that the path specified for
HPSiteScopeOperationsManagerIntegration.log is correct (it might use an environment variable). If
youmake any changes here, youmust install the policies again.

7. Check if the agent received the event and sent it to HPOM/Operations Management:

Make sure that the agent knows the location of the log file.

On Windows:Check if %SITESCOPE_HOME% variable is defined. If it is not defined:

a. Define%SITESCOPE_HOME%.

b. Remove the policy:

ovpolicy -remove -polname HP_SiteScope_to_Operations_Manager_Integration_by_Log_
File

c. Reinstall the policies from the SiteScope user interface.

On UNIX:Check if the log file policy contains the location of the log:

a. Open the policy:

“opt/HP/SiteScope/tools/OMIntegration/Policies/F516CEC3-3AD4-4627-9CFD-
BB155B894349_data”

b. Check LOGPATH is set to "opt/HP/SiteScope
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logs/HPSiteScopeOperationsManagerIntegration.log"

If it is not, change the path and reinstall the policy (see theWindows steps above).

8. If you still do not see the event in the HPOM Event Console/Operations Management Event Browser,
check:

l You are viewing the correct node (in HPOM).

l You are not filtering out anything (in the Operations Management Event Browser).

Otherwise contact support.

Symptom 2:

Themetric status change or alert event is not displayed in the HPOM Event Console/Operations Management
Event Browser.

Troubleshooting:

1. Check if the test event is displayed in the Event Console/Browser. If it is not displayed, follow the
guidelines for Symptom 1 in "Problems Sending Events" on the previous page.

2. Check that event integration is enabled in themonitor or alert configuration settings. Change themonitor
metric status, or trigger an alert. In the <SiteScope root directory>\logs directory, check the events log
file, HPSiteScopeOperationsManagerIntegration.log.

3. If you do not see the event entry in the log file, check you enabled event integration correctly in the
monitor or alert you are running (for details, see "How to Enable SiteScope to Send Events to HPOM or
Operations Management" on page 19). If it is still not in the log file, contact HP Software Support.

4. If you see the event entry in the log file, but not in the Event Console/Browser:

a. Check that no filter is set in the Event Browser.

b. If it is a newly-createdmonitor, and you are filtering the related CI in Operations Management, it is
possible that the CI topology is not reported yet. Try again in a few minutes.

c. In HPOM legacy, make sure the event target node exists on your console.

d. Contact HP Software Support.

Symptom 3:

You see themetric or alert event in the Operations Management Event Browser, but it has no related CI or HI,
or Indicator state or severity.

Troubleshooting:

1. Check the event attribute values in theHPSiteScopeOperationsManagerIntegration.log file located in
the <SiteScope root directory>\logs directory. Look for the HI (ETI) and CI hint. They should look like
this: CPULoad:High:80 and SiteScope:3:123456 respectively.

a. To know the attribute order in this tab separated values line, you can send a test event before this
event and compare the lines. The test event writes the name of each attribute in its order.

Integration with HP Operations Manager Products
Chapter 13: Troubleshooting Event Integration Issues

HPE SiteScope (11.32) Page 63 of 88



b. If the CI Hint or HI hint are unknown, empty, or look different than the example, there is a problem with
the SiteScope configuration.

o Check that the SiteScope is registered to BSM.

o Check that themonitor thresholds have indicator states assigned to them, or that your alert has
some ETI and ETI state set.

o Check the preference setting for reporting SiteScope data in themonitor configuration is set to
Events (inHP Integration Settings > BSM Service Health Preferences).

2. If everything looks fine in the log file in SiteScope, open the event in the Operations Management Event
Browser.

a. In theGeneral tab, check the related CI attribute. If you do not see the related CI, select the
Resolver tab and check theStatus field.

o Check if there is information about the CI resolution failure.

o Check that themonitor topology is available in the BSM (you can check this in the System
Hardware or SystemMonitors views).

Note: If this is a newly-createdmonitor, it will take few minutes for the topology to arrive and
the event to be assigned with a related CI.

b. In theGeneral tab, if you see the related CI but Event Type Indicator is empty:

o Select theResolver tab and check the ETI Hint attribute value sent by SiteScope. If it is empty or
unknown, check your SiteScope configuration.

o If the value exists but does not show up inEvent Type Indicator in the General tab, there was a
problem when applying the indicator to the CI. Check Service Health or Operations Management
for support.

Node Discovery and Monitor Discovery
Troubleshooting
Node Discovery:

l If you are using Operations Manager forWindows 8.1x, patch OMW_00071 is required to support the Node
discovery feature in SiteScope-HPOM event integration.

l If you are using Operations Manager forWindows 9, patch OMW_00097/98 or later (32-bit/64-bit) is
required to support the Node discovery feature without overriding SiteScope node properties.

l If you are using Operations Manager for Solaris/HP-UX/Linux 9.10, patch 9.10.200 is required to support
the Node discovery feature in SiteScope-HPOM event integration.

Troubleshooting problems with Node discovery:

1. Click theAnalyze button in the HP Operations Manager Integration dialog box. Make sure you see the
SiteScope_Hosts_Discovery policy installed and enabled.
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2. Check that your event configuration is set. Send a test event andmake sure you see it in the HPOM
Event Console on the SiteScope node.

New nodes are reported within 5minutes from the time they started to beingmonitored by SiteScope
monitors.

The discovery policy runs SiteScope scripts that generate XML consumed by the policy. Each run is
logged in the following log:%OvDataDir%\log\System.txt (for Linux <SiteScope
Server>/var/opt/OV/log).

3. You can invoke the process manually, by running the following commands:

ovagtrep -run "SiteScope_Hosts_Discovery"ovagtrep -publish

Monitor Discovery:

To enable HPOM Service Navigator to view SiteScope groups andmonitors in HPOM servicemaps, follow
the configuration instructions in "How to Enable the SiteScopeMonitor Discovery Policy" on page 36.

Certificate Requests Do Not Reach the Operations
Management Server
Problem:Event integration between SiteScope and BSM could not be created because certificate requests
are not reaching the Operations Management server.

Troubleshooting:Run the following command on theOperations Manager server:

"ovconfchg -ns sec.cm.server -set IsIPV6Enabled FALSE"
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Chapter 14: Configuring SiteScope to Report
Metrics for Use in HPOM or Operations
Management
SiteScopemakes its metrics data available for use in PerformanceManager (the reporting component of
HPOM) and PerformanceGraphing in BSM's Operations Management.

l ForPerformance Graphing in Operations Management, you can use either of the following data sources
for reporting data to BSM:

l Profile database in BSM, as part of the BSM integration (this is the recommended data source).

l Operations Agent installed on the SiteScope server, as part of the Operations Manager metric
integration.

Note:While reportingmetrics data to the Operations Agent is supported for PerformanceGraphing
in this release, HPE plans to stop supporting it in the future, and recommend that you use the BSM
profile databasemethod instead.

l ForPerformance Manager in HPOM, youmust use the Operations Agent installed on the SiteScope
server, as part of the Operations Manager metric integration.

For details on reporting data to BSM using the profile database, see "Reporting Data to the Profile Database in
BSM" on the next page.

For details on reporting data to the Operations Agent, see "Reporting Data to theOperations Agent" on
page 69.
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Reporting Data to the Profile Database in BSM
By default, SiteScope reports metrics data to the profile database in BSM. When a user in Performance
Graphing in Operations Management draws or designs a graph, PerformanceGraphing collects the data from
the profile database for the CI monitored by SiteScope, and draws the graph.

The advantages of using a profile database for reporting data to PerformanceGraphing, include:

l No additional configuration is required.

l Better performance and scalability than the Operations Agent.

l Easier to troubleshoot than the Operations Agent.

For details on configuringmetrics integration using a profile database, see "How to Enable SiteScope to
Report Metrics to Profile DB in BSM" on page 71.
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Reporting Data to theOperations Agent
SiteScope reports metrics data to the Operations Agent store installed on the SiteScope server. This data can
then bemade available to PerformanceManager (the reporting component of HPOM) and to Performance
Graphing (in Operations Management).

Note:While reportingmetrics data to the Operations Agent is supported for PerformanceGraphing in this
release, HPE plans to stop supporting it in the future, and recommend that you use the BSM profile
databasemethod instead. For details, see "Reporting Data to the Profile Database in BSM" on the
previous page. Reportingmetrics to the Operations Agent as part of the Operations Manager metric
integration is still supported for makingmetrics available in PerformanceManager.

When a user in PerformanceManager draws or designs a graph, PerformanceManager collects metrics data
from the agent data store for the selected node in PerformanceManager that is monitored by SiteScope, and
draws the graph. Agentless graphing is supported in PerformanceManager 9.0 or later. For details on
PerformanceManager, refer to the PerformanceManager documentation. Metrics data collected from
SiteScope can also be used in PerformanceGraphing.

Sizing is important for planning themaximum number of monitors, metrics, andmonitors types that can be
stored within the SiteScope-HPOMmetrics integration. For sizing recommendations, see "Sizing
Recommendations for SiteScope-Operations Manager Metrics Integration" on page 82.
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Metrics name alignment, the process of aligningmetrics names in SiteScope with those used in HPOM or
BSM, has been performed for some of themost commonly usedmonitors. For details, see "SiteScope-
Operations Agent Metrics Alignment" on page 78. PerformanceManager can graph any metrics (whether
aligned or not), andmetrics alignment for all possible metrics is not required for viewing the data in
PerformanceManager.

For details on configuringmetrics integration, see "How to Enable SiteScope to Report Metrics to the
Operations Agent" on page 74.

Note:

l Metrics integration using the Operations Agent should not be confused with the integration of
SiteScopemonitor metrics used by the various BSM applications when calculating status for CIs (for
example, in Service Health, Service Level Management, and System Availability Management). For
details on BSMmetrics integration, see the Connecting to a BSM Server section of the Using
SiteScopeGuide in the SiteScope Help.

l Metrics integration with PerformanceManager can be activated regardless of the connection status
between theOperations Agent and the HPOM or BSM server, sincemetrics are collected by the
agent.

l TheOperations Manager metrics integration is supported by SiteScopes running onWindows and
UNIX platforms for HPOM andOperations Management.

Tip: For best practices and troubleshooting for reportingmetrics data to BSM andHPOM products using
the Operations Agent, see the Integration with BSM andHPOM Best Practices Guide available from the
SiteScope Help.
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Chapter 15: How to Enable SiteScope to
Report Metrics to Profile DB in BSM
This task describes how to enable SiteScope to report metrics data to profile database in BSM.

1. Prerequisites
l Your systemmust conform to the following requirements:

o SiteScope version 11.00 or later is installed.

o For Operations Management, BSM 9.22 or later is installed.

2. Configure SiteScope to Communicate with BSM
SiteScopemust be connected to a BSM server, and reportingmonitor metrics to BSM should be enabled
in HP Integration Settings.

For details on configuring SiteScope to communicate with BSM, see the section on connecting
SiteScope to a BSM server inUsing SiteScope in the SiteScope Help.

For details on enabling BSM logging options and topology reporting settings for monitor instances, see
the section on HP Integration Settings inUsing SiteScope in the SiteScope Help.

3. Select Profile DB as the Data Source in BSM Infrastructure Settings
By default, SiteScope reports metrics data to the profile database tomake it available to Performance
Graphing in BSM's Operations Management.

Tomodify the data source setting in BSM inAdmin > Platform > Setup and Maintenance >
Infrastructure Settings:

l Select Applications.

l Select Performance Graphing.

l In the PerformanceGraphing table, locateSiteScope Datasource Name, andmake sure that Profile
DB is selected.

4. Results
When SiteScope reports metrics to BSM, the data is stored in the profile database.

When a user in PerformanceGraphing in Operations Management draws or designs a graph, themetrics
data is collected from the profile database.

A user can select the following in the Performance Perspective page:

l Data Sources. Displays the profile name of the SiteScope CI that should be used by performance
grapher.
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l Metric Classes. Displays themonitor types on the SiteScope CI.

l Instances. Displays monitor instances on the SiteScope CI. Instances are in the format: <SIS
profile name>-<full monitor pathname>.

l Metrics. Displays monitor metrics for the selectedmetric classes (monitor type).
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Chapter 16: How to Change Data Source from
Profile DB to Operations Agent
This task describes how to change the data source from Profile DB to the Operations Agent to make the data
available in HPOM (PerformanceManager) andOperations Management (PerformanceGraphing).

Note:While the Operations Agent is supported for reporting data to PerformanceGraphing in this release,
HPE plans to stop supporting it for reportingmetrics data to PerformanceGraphing in the future, and
recommend that you use the profile databasemethod instead. Reportingmetrics to the Operations Agent
as part of the Operations Manager metric integration is still supported for makingmetrics available in
PerformanceManager.

1. Select HP Operations Agent as the Data Source in BSM Infrastructure Settings
Modify the data source setting in BSM inAdmin > Platform > Setup and Maintenance >
Infrastructure Settings:

l Select Applications.

l Select Performance Graphing.

l In the PerformanceGraphing table, locateSiteScope Datasource Name, and select Embedded HP
Operations Agent.

2. Enable SiteScope to report metrics data to the HP Operations agent to make it
available in HPOM and Operations Management
Perform the steps described in "How to Enable SiteScope to Report Metrics to the Operations Agent" on
page 74.
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Chapter 17: How to Enable SiteScope to
Report Metrics to the Operations Agent
This task describes how to enable SiteScope to report metrics data to the Operations Agent to make it
available in HPOM (PerformanceManager) andOperations Management (PerformanceGraphing).

Note:While reportingmetrics data to the Operations Agent is supported for PerformanceGraphing in this
release, HPE plans to stop supporting it in the future, and recommend that you use the BSM profile
databasemethod instead. For details, see "Reporting Data to the Profile Database in BSM" on page 68.
Reportingmetrics to the Operations Agent as part of the Operations Manager metric integration is still
supported for makingmetrics available in PerformanceManager.

1. Prerequisites
l Your systemmust conform to the following requirements:

o SiteScope version 11.00 or later is installed.

o For Operations Management, BSM 9.00 or later is installed.

o For HPOM, PerformanceManager 9.0 or later is installed.

Note: The node discovery, monitor discovery, and template integration are not supported for
all versions of HPOM. For details of the integrations that are supported and of any patch
requirements, refer to the Operations Manager (HPOM) Integration Support Matrix in the HP
SiteScope Deployment Guide (available from the HPE Software Support site.

l Only a SiteScope administrator user, or a user grantedEdit integration preferences permissions.
can configure the integration. For details on user permissions, see the section on user management
preferences in the Using SiteScopeGuide in the SiteScope Help.

l The PerformanceManager administrator must configure PerformanceManager to connect to the
SiteScope node where the SiteScope instance is logging data. For details, refer to the Performance
Manager documentation.

l (If SiteScope is installed on a RedHat ES Linux 6.0 64-bit environment) Youmust install the following
dependencies before installing the Operations Agent:

o Install compat-libstdc++-33-3.2.3-69.el6.i686.rpm on the Red Hat Enterprise Linux 6 x64 node.

Note: To install SiteScope with the Operations Agent on RHEL x64 in graphics mode, you
must run the installer with themachine default 64-bit JRE.

./<PRODUCT_NAME>_<VERSION>_setup.bin LAX_VM /usr/bin/java $@
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For example, if /usr/bin/java points to the 64-bit JRE or JDK:

./HPSiteScope_11.30_setup.bin LAX_VM /usr/bin/java $@

o Install compat-libstdc++-33-3.2.3-69.el6.ppc64.rpm on the Red Hat Enterprise Linux 6 PPC
node.

You can install the dependencies, using the yum packagemanager provided in Red Hat Enterprise
Linux, by running the command:

o yum install compat-libstdc++-33-3.2.3-69.el6.i686

or

o yum install compat-libstdc++-33-3.2.3-69.el6.ppc64

2. Install the HP Operations agent on the SiteScope server
The agent enables SiteScope to act as data storage for metrics data collected by SiteScope.

Install HP Operations Agent 11.14 from the SiteScope installer package, or download it from the HPE
Software Support web site (in the Search box, type "Operations Agent", select the relevant version,
under Document Type, select Patches, and locate the installation file).

Note: If an older version of the agent is already installed, or the agent is already integrated with
OMi/OMu/OMw, you should:

a. Upgrade the agent according to the instructions in the HPE Operations Agent 11.14 Installation
Guide.

b. Configure the agent using the SiteScope Configuration Tool as described in step 3 below.

OnWindows:

a. Log on to the node with the administrator privileges.

b. Go to the directory where you extracted the contents of the ISO file.

c. Run the following command to install the agent:

cscript oainstall.vbs -i –a

OnUNIX/Linux:

a. Log on to the node with the root privileges.

b. Go to the directory where you extracted the contents of the ISO file.

c. Run the following command to start the installation:

./oainstall.sh -i -a

d. When the installation is complete, the agent starts its operation on the node and all the necessary
components start running.

For more detailed installation instructions, see the Operations Agent 11.14 Installation Guide, available
from the HPE Software Support site.
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Note:

l Only Operations Agent version 11.14 is certified with SiteScope 11.3x.

l Use the -includeupdates installation option to install Operations Agent 11.14 with pre-packed
hotfixes. For details, refer to the Operations Agent 11.14 Installation Guide.

l To enable the Operations Manager metrics integration, the Operations agent on the SiteScope
machinemust run under the same user as in SiteScope, namely a non-root user. For details, see
Configure an Agent to run Under an Alternative User on UNIX in the Operations Manager for
UNIX - HTTPS Agent Concepts and Configuration Guide.

3. Complete the HP Operations Agent installation using the SiteScope
Configuration Tool

Note: This stepmust be performed before integrating the Operations Agent to HPOM.

a. Run the SiteScope Configuration Tool on the SiteScope server:

o OnWindows: Select Start > All Programs > HP SiteScope > Configuration Tool.

o On Linux (graphic mode): Run <SiteScope install Directory>/bin/config_tool.sh.

o On Linux (consolemode): Run /opt/HP/SiteScope/bin/config_tool.sh -i console.

For more details on using the SiteScope Configuration Tool, see the HPE SiteScope Deployment
Guide (available from the HPE Software Support site).

b. In theConfigure HP Operations Agent installed separately option (HP Operations Agent option
in consolemode), select Configure HP Operations Agent to complete the installation of the
Operations Agent.

c. Restart SiteScope (if required).

d. (If the agent is installed on a RedHat ES Linux 6.0 environment) After installing the Operations
Agent, check the installation status in the log files.

o SiteScope log. This just shows whether the installation passed successfully or not.

Log file name: HPSiteScope_config_tool.log

Log file location:

l win- %temp% onWindows platforms

l /temp or /var/temp on UNIX/Linux platforms

(search for results of "installOATask")

o Operations Agent log files.

Log file name: oainstall.log, oapatch.log

Log file location:
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l %ovdatadir%\log onWindows platforms

l /var/opt/OV/log/ on UNIX/Linux platforms

4. Enable SiteScope to send metrics
In SiteScope, navigate toPreferences > Integration Preferences, and create a new or edit an existing
HP Operations Manager integration. In the HP Operations Manager Integration dialog box, expand the
HP Operations Manager Metrics Integration panel and select Enable HP Operations Manager
metrics integration.

Note: Metrics integration with Operations Manager can be activated regardless of the connection
status between theOperations Agent and the HPOM/BSM server, sincemetrics are collected by the
agent.

5. Enable monitor instances to send metrics
For eachmonitor instance that you want to report metrics data to the agent data storage, expandHP
Integration Settings in themonitor properties, and select Report metrics to HP Operations agent in
theHP Operations Manager Integration Settings section.

Tip: You can automatically enablemetrics reporting for particular monitor types without having to
select Report metrics to HP Operations agent for eachmonitor instance. To do so, select
Integration Preferences > HP Operations Manager Integration, expand theHP Operations
Manager Metrics Integration panel, and:

l Select Enable metrics reporting for new monitors to enable SiteScope to report metrics to
the HP Operations agent for all newly-createdmonitors.

l Click theEnable metrics reporting for specific monitors button to enable reportingmetrics
for Memory, CPU, Disk Space, andWindows Resources monitors only.

6. Results
Eachmonitor metric is logged as an instance by the agent on the SiteScope host node, with the time and
host as the instance identifier. Themetrics data is collected from the agent data storage by HPOM and
BSM for use in the reporting products.

Metrics error data is written to the oa_metric_integration.log file which is found in the <SiteScope root
directory>\logs directory.

For notes and limitations onmetrics integrations, see "Notes and Limitations" on page 84.

For troubleshootingmetrics integration issues, see "TroubleshootingMetrics Integration Issues" on
page 84.
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Chapter 18: SiteScope-Operations Agent
Metrics Alignment
Metrics name alignment is the process of aligningmetrics names in SiteScope with those used by Operations
Manager Performance Agent (PA). PerformanceManager can graph any metrics (whether aligned or not), and
metrics alignment for all possible metrics is not required for viewing the data in PerformanceManager.

For more information onmetrics provided by Performance Agent, refer to the Performance Agent Metric Help
Viewer in the Performance Agent 5.0 documentation
(https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM864772).
To enter the HP Software Self-solve Knowledge Base, youmust log on with your HPE Passport ID.

Metrics name alignment has been performed for the commonly usedmetrics listed below.

PA Metrics Name

(Display Name) SiteScope Metrics Name

BYCPU_CPU_TOTAL_
UTIL

(Total CPU%)

Windows:

l CPU Monitor \utilization (cpu #1, cpu #2, etc)

l Microsoft Windows Resources Monitor \Processor\{instance}%\
Processor Time

Linux:UNIX Resources Monitor \Processor\{instance}\System

HP-UX:N/A

Solaris:N/A

AIX: UNIX Resources Monitor \Processor\{instance}\%sys

BYNETIF_IN_BYTE_RATE

(In KB Rate)

Windows:Microsoft Windows Resources Monitor \Network Interface\
{instance}\Bytes Received\sec

Linux:N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A
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PA Metrics Name

(Display Name) SiteScope Metrics Name

BYNETIF_OUT_BYTE_
RATE

(Out KB Rate)

Windows:Microsoft Windows Resources Monitor \Network Interface\
{instance}\Bytes Sent\sec

Linux:N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A

BYDSK_PHYS_READ_
BYTE_RATE

(Phys Read KB Rate)

Windows:Microsoft Windows Resources Monitor \Physical Disk\
{instance}\% Disk Read Bytes\sec

Linux: N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A

BYDSK_PHYS_WRITE_
BYTE_RATE

(Phys Write KB Rate)

Windows:Microsoft Windows Resources Monitor \Physical Disk\
{instance}\% Disk Write Bytes\sec

Linux: N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A

BYDSK_REQUEST_
QUEUE

(ReqQueue)

Windows:Microsoft Windows Resources Monitor \Physical Disk\
{instance}\Avg. Disk Queue Length

Linux: N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A
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PA Metrics Name

(Display Name) SiteScope Metrics Name

BYDSK_UTIL

(Disk %)

Windows:Microsoft Windows Resources Monitor \Physical Disk\
{instance}\% Disk Time

Linux: N/A

HP-UX:UNIX Resources Monitor \Block device activity\<device>\%busy

Solaris:UNIX Resources Monitor \Block device activity\<device>\%busy

AIX: UNIX Resources Monitor\Block device activity\<device>\%busy

FS_SPACE_UTIL

(Space%)

Windows:Disk SpaceMonitor \percent full

Linux: Disk SpaceMonitor \percent full

HP-UX:Disk SpaceMonitor \percent full

Solaris:Disk SpaceMonitor \percent full

AIX: Disk SpaceMonitor \percent full

GBL_CPU_TOTAL_UTIL

(CPU %)

Windows:

l CPU Monitor \utilization (avgas)

l Microsoft Windows Resources Monitor \Processor\_Total\% Processor
Time

Linux: UNIX Resources Monitor \Processor\Total\System

HP-UX:N/A

Solaris:N/A

AIX: UNIX Resources Monitor\Processor\Total\%sys

GBL_MEM_PAGEOUT_
RATE

(PgOut Rate)

Windows:Microsoft Windows Resources Monitor \Memory\Pages
Output/sec

Linux: N/A

HP-UX:N/A

Solaris:UNIX Resources Monitor \Page-out memory andmemory freeing
activities\ppgout/s

AIX: N/A
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PA Metrics Name

(Display Name) SiteScope Metrics Name

GBL_MEM_UTIL

(Memory %)

Windows:Memory Monitor \percent used

Linux: N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A

GBL_SWAP_SPACE_UTIL

(Swap%)

Windows:Microsoft Windows Resources Monitor \Memory\% Committed
Bytes In Use

Linux: N/A

HP-UX:N/A

Solaris:N/A

AIX: N/A
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Chapter 19: Sizing Recommendations for
SiteScope-Operations Manager Metrics
Integration
While the default SiteScope configuration enables running thousands of monitors, sizing is important for
planning themaximum number of monitors, metrics, andmonitors types that can be stored within the
SiteScope-HPOMmetrics integration.

The sizing should not exceed:

l Maximum insertion rate of 1000metrics per minute.

l Total retention storage of 1 GB.

l Total retention period of 5 weeks.

Definitions
The following are definitions of the terms used in the validation calculations below:

l Monitors. The number of monitors that report metrics to HPOM PerformanceManager.

l Metrics. The average number of metrics of the abovementionedmonitors that report to HPOM
PerformanceManager.

l Frequency. The average frequency at which the abovementionedmonitors feed data into the integration.

Validation
When choosing the specific SiteScopemonitors andmetrics to store within the SiteScope-HPOMmetrics
integration, you should validate that the insertion and retention rates do not exceed the recommendations. You
can do that using the formulae below:

l Supported Insertion Rate Validation:

(Monitors * Metrics) / Frequency <= 1000 metrics/minute

l Supported Retention Period Validation:

(1000 MB) / ((Monitors * Metrics / Frequency) * 0.07 MB) = configured retention period
in days
(which should be less than themaximum retention period of 5 weeks)

where 0.07 MB is the storage size for eachmetric/minute per day.
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Example
If you have 2500monitors that report data using the HPOMmetrics integration, and every monitor has 4
metrics, the frequency of thesemonitors is every 10minutes, and the averagemetric storage size per day is
0.07MB, you will be able to store your historical data for 14 days.

Validation calculations:

l Insertion Rate Validation:

(2500monitors * 4metrics) / 10minutes = 1000 <= 1000metrics/minute

l Retention Period Validation:

1000MB / (((2500 * 4Metrics) / 10minutes) * 0.07MB) = 14.28 days (<= 5 weeks)
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Chapter 20: Troubleshooting Metrics
Integration Issues
This section includes:

l "Notes and Limitations" below

l "Troubleshooting the HP Operations Agent Configuration" on the next page

l "Health Monitors Errors" on page 86

l "HP PerformanceManager Configuration" on page 86

l "CI Resolution does not work ("BadHint error" in the cir_enrichment.log)" on page 86

l "System runs out of ports when reporting data to the HP Operations agent" on page 87

Notes and Limitations
l The agent data store supports only alphanumeric and the underscore (_) character in SiteScopemetric
names. All other characters are converted to supported characters (themetric display name (heading)
remains in the SiteScope style).

l WebScript monitor data cannot be reported…toOperations Management or HPOM.

l After upgrading from PerformanceManager to PerformanceGraphing and connecting SiteScope to BSM,
historical report data cannot be upgraded since it does not have CI-based reporting capability (it can still be
viewed in the old PerformanceManager way).

l To enable reporting numerical values with postfixes (such as 25% or 400MB) to the agent data store, add
the list of postfixes, separated by commas, to the _omMetricIntergationAllowedNumberPostfixs
property in the <SiteScope root directory>\groups\master.config file. For example, to include%, MB,
KB, andGB, add =%,mb,kb,gb. Note that all postfixes should be in lower case.

l In anOperations Management Manager of Managers configuration (wheremultiple HPOM servers are
connected to Operations Management, andmultiple SiteScopes are connected to the HPOM servers, and
indirectly to Operations Management), data sent from SiteScope is not supported by Performance
Graphing, since SiteScope does not send topology to Operations Management. For details on Operations
Management deployment configurations, see the section on Connected Servers in the BSM Application
Administration Guide.

l To prevent overloading the agent data store, follow the sizing recommendations as described in "Sizing
Recommendations for SiteScope-Operations Manager Metrics Integration" on page 82.
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Troubleshooting the HP Operations Agent
Configuration
Check the HP Operations Agent Configuration

1. Check the status of the HP Operations agent installed on the SiteScope server by running the following
command: opcagt -status

The expected output is:

If opcacta or opcmsgi are not running, try to restart the agent by running:

opcagt -stop

opcagt -start

2. Select Preferences > Integration Preferences, and select an existing or create a new HP Operations
Manager Integration. Verify that theEnable sending events check box is selected.

3. Under the Properties tab for themonitor, expand the HP Integration Settings panel, and verify that the
Report metrics to HP Operations agent check box is selected.

4. Run themonitor, and wait for about aminute.

5. Run the following command to check if the agent data store contains the data:

set CODAMAGIC=0X05201993

ovcodautil -obj -ds AGENTLESS

You should receive object names from AGENTLESS data source (similar to the following):

6. To dump the summarized last record for AGENTLESS data source, run the following command:

ovcodautil -dumpds AGENTLESS

Check the Relevant SiteScope Logs
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Check the following logs that are available from the <SiteScope root directory>\logs directory:

l error.log

l RunMonitor.log

l om_metric_integration.log

l data_integration.log

Health Monitors Errors
In the SiteScopemonitor tree, expandHealth and click Log Event Checker.

l If the Failed to report data to HP OM Agent counter is in error, SiteScope failed to connect or report
data to the HP Operations agent using Java API. For more information, see the oa_metric_
integration.log file in the <SiteScope root directory>\logs directory.

l If theGeneric Data Integration queue exceeded allowed size counter is in error, the queue of metrics
waiting to be sent is oversized and somemetrics were dropped tomaintain SiteScope stability. For more
information, data_integration.log file in the <SiteScope root directory>\logs directory.

HP Performance Manager Configuration
1. On the PerformanceManager server, open theOVPMconfig.ini file in the

%ovdatadir%\shared\server\conf\perf directory.

2. Update the SiteScope server details as follows:

l [SITESCOPE]

l SERVER = servername

l NODEGROUP = Agentless

3. Restart the HP Openview Tomcat(B) service.

CI Resolution does not work ("BadHint error" in the
cir_enrichment.log)
1. Go toAdmin > Platform > Infrastructure Setting.

2. In theApplication dropdown, select End User/System Availability Management.

3. In theSiteScope CI Resolver Settings, check for TQL Queries value.

The default value is CIs Monitored by SiteScope (in BSM versions earlier than 9.20).

4. Go toAdmin > RTSM Administration and check forCIs Monitored by SiteScope query results. If
you do not get the requested CI in the query results, CI resolution will not find it as well.
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Possible problem: CI has missing attributes or the SiteScopemonitor CI is not connected to any
monitored CI.

System runs out of ports when reporting data to the
HP Operations agent
Problem: The system runs out of ports when reportingmetrics data to the HP Operations Agent in a loaded
environment.

l In SiteScope Health, an error is displayed in the Log Event Checker monitor for the .*Failed to report data
to HP OM Agent.* counter.

l In the oa_metric_integration.log, the following error is displayed: "ERROR - Failed to report data to
/Hewlett-Packard/OpenView/Coda/ IO error while gettingSingle Object;Address already in use: connect".

Possible solution: Increase the upper range of ephemeral ports and reduce the client TCP/IP socket
connection timeout value inWindows. For details, see http://msdn.microsoft.com/en-
us/library/aa560610%28v=bts.20%29.aspx.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an email
client is configured on this system, click the link above and an email window opens with the following
information in the subject line:

Feedback on Integration with HP Operations Manager Products (SiteScope 11.32)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and send
your feedback to sitescope-doc-feedback@hpe.com.

We appreciate your feedback!
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